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Introduction to the Sabre System
Quick Reference

Y O U R I N F O R M A T I O N

Welcome to the Sabre® system!

The Sabre® system has consistently been rated the number one Global Distribution System (GDS) in the world and continues to maintain a
leadership position in bookings share. You now have at your fingertips a host of technology solutions that will serve as your gateway to a wide variety
of travel and travel-related services.

Sabre Travel Network® connects travel buyers and sellers through the world’s largest global distribution system, providing over 50,000 travel agency
locations with instant access to content from airlines, hotels, car rental companies, cruise lines and more

Our end-to-end corporate and leisure solutions help you work smarter, reduce costs, generate more revenue and build stronger customer
relationships

Whether you’re in transition from proficiency with another Global Distribution System to the Sabre® system or are new to the travel industry, we want
to help you gain a working knowledge and understanding of the Sabre system as quickly as possible. It is not important to remember all the formats.
Memorization of formats will come with time. However, it is important for you to know where to locate the answers to your questions and to feel
confident in planning your continued training.

If known, record your agent ID, agent sign, and agency pseudo city code below for reference.

Agent ID:

Agent sign:

Agency Pseudo City Code (PCC):
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Sabre System Keyboard
Quick Reference

S A B R E S Y S T E M K E Y B O A R D

C O M P O N E N T F U N C T I O N

1. PF keys Also called function keys. Used to store formats that are used repeatedly.

2. Main keyboard Number and letter keys used for most typing and entry functions.

3. Miscellaneous keys Used to insert and delete information, reenter, reset cursor to top left
margin of screen, and place text in the upper portion of the screen.

4. Arrow keys Used to move the cursor up, down, left, and right on the screen.

5. Numeric key pad Functions as a calculator.

6. Alt key Performs a function if depressed in conjunction with another key.

7. Ctrl key Performs a function if depressed in conjunction with another key or keys.

8. Identification Code Keys (ICK) Agents use these keys, combined with letters and numbers, to perform
specific functions in the Sabre system.
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I D E N T I F I C A T I O N C O D E K E Y S ( I C K )

Use the keys below for particular functions, such as create or display a Passenger Name Record (PNR).

Key Function Description and Sample Format

1 Availability
Displays city pair availability.
122JANFRAMAD

2 Flight Information
(FLIFO)

Request flight Information.
2UA2550/17OCT

3 General Passenger Information
(GFAX)

Send general passenger information to all airlines
except American Airlines.
3OSI DL HAS BROKEN LEG

4 General Passenger Information for AA
(AFAX)

Send general passenger information to American
Airlines.
4OSI HAS BROKEN LEG

5 Remarks
Add remarks about the passenger or the reservation.
5NEEDS HYATT HOTEL IN SYDNEY

6 Received From
Add “received from” (the person from whom the
reservation request was received).
6NIGEL

7 Ticketing
Add ticketing deadline.
7TAW22JAN/

8 Time Limit
Add time limit – automatically cancels the reservation
if no ticket is issued.
86P/17JUN

9 Phone Number
Add phone number.
9415-555-2121-H

0 Sell Segment
Sell segment (air, car, hotel, etc).
01Y1

- Name
Add passenger name.
-ALONSO/EDITH

* (=) Display
Displays information when used in combination with
other characters.
*-SANCHEZ
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O T H E R I D E N T I F I C A T I O N C O D E K E Y S

Key Name Description and Sample Format

Insert After Segment

/

Used to rearrange segments (Example: insert after segment 0 insert segment 2).
/0/2

Change Segment Status

.

New Number in Party

,

Used to change the action/status code of a segment.
.2HK

Used to change the number in party.
,2

Change

¤

End-Item

§

Used to change, delete or calculate information.
91¤214-555-2121-H

Used to string several Sabre system entries together.
-PARK/JOHN MR§9305-555-3442-B§6JOHN§7TAW22JAN/

Cross of Lorraine

¥

Used as a separator.
W¥PQ1¥KP0¥ALH

E D I T I N G K E Y S

Key Description

Left and Right arrow keys May be used to move forward and backward through a format to position the cursor and type over mistakes.

Note: Though the Up and Down arrow keys can be used to move the cursor, the system cannot read the
starting point if these keys are used. Use the Reset key to make sure the system knows where the entry
begins.

Insert and Delete keys May be used to insert and delete characters in a format. Often used in conjunction with the Left and Right
arrow keys to insert or delete characters after moving forward or backward through a format.

Sabre System Keyboard Quick Reference Page | 3



Working in the Sabre system page 8

S P E C I F I C F U N C T I O N K E Y S

Specific keys allow you to transmit information to the system, reposition your cursor, and even clear your screen. The location of these keys may be
different on the keyboards in your office, but the functions of the keys are the same.

Note: The cursor is a blinking character on the Sabre system screen that indicates placement of the next character to be typed. The cursor
automatically returns to the left margin after every entry.

Key Function

Clear Used to clear the screen without canceling or changing any of the data previously entered. The
cursor is returned to the upper left corner of the screen.

Home Moves the cursor from the current position to the upper left corner of the screen. Data on the
screen is not erased. This key will reset your SOM (Start of Message). You may use it to return
the cursor to the top of the screen after entering data or requesting information from the system.

Escape Returns the cursor to the left margin of the screen, one line at a time, without erasing the previous
line. This key will reset your SOM to the beginning of the next line on your screen. If you have
begun an entry that you do not want to complete, you may use this key to disregard the current
entry and begin a new one.

Reset If the “Sabre Keyboard” mode (under the Options menu) is active, this key may also be used as a
Reset key.

ReEnter Allows you to input a previously entered format without retyping all of the data. After making a
correction to a format, moving the cursor to the end of a long entry before pressing Enter can be
tiresome. The ReEnter key moves the cursor quickly to the end of the entry and resends it to the
system.

Replay Redisplay the last format entered. You can replay approximately 350 of your most recent Sabre
system entries.
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Signing into the Sabre System
Quick Reference

O V E R V I E W

Employee Profile Records (EPRs) are an element of the Sabre® global distribution system’s security that governs the capabilities of agents using the
Sabre system. Your EPR enables you to sign into the Sabre system and controls which functions you can or cannot perform in the system.

EPRs contain many different components including:

 agent id – use this to sign-in

 agent sign - identifies each specific agent

 office code – allows you to group agents by job function

 duty codes – allow specific functionality

 keywords – allow specific functionality

 passcode (password) – secures your sign-in and allows access to
the system

EPR example. See the Format FinderSM help system for a detailed explanation of each EPR field.

Agent Name
Pseudo City Code (PCC0)
and Agent Sign (A71)

Agent ID (0000) and
Pseudo City Code (PCC0)

Office Code

Duty Codes

EPR Status

Last date of display

J SANCHEZ PCC0-A71 0000-PCC0
OFC-CORP ASO-60
SIGN IN ACCESS – PCC0
DUTY 6 9 * /
UAT- ACCESS ARCRPT COMMSG CCVIEW CIIMGR CREATE

MINOPR MULSET PFKAGT SUBAAA SUBACC SUBMGR
STATUS - ACTIVE 15MAY86 PASSCODE
H D CREATED BY PCC0-AKP 15MAY86 0430A
06JAN15 0421P CST

Keywords (ACCESS,
ARCRPT, etc.)

EPR creation date, time and
create agent sign

Note: Find more information about EPRs in the Format Finder help system.

N E W A G E N C Y - I N I T I A L E P R A N D P A S S C O D E

Every new Sabre ConnectedSM agency is issued one initial EPR and a temporary (default) passcode. You will use this EPR and passcode the first
time you sign-in to the Sabre system.

 You must change your initial EPR passcode, your new passcode must consist of 7 or 8 alphanumeric characters and it may NOT include Q or
Z.

 You must then use this initial EPR to create an EPR for yourself and for each agent.

Important Note: To ensure agency security, it is important to DELETE the initial EPR.

P A S S C O D E R E Q U I R E M E N T S

Follow these requirements when creating or changing your Sabre system passcode. All new EPRs you create must have a passcode before you can
end transaction and activate the EPR.

 Must be 7 or 8 alphanumeric characters

 Must contain at least 1 alphabetic and 1 numeric character

 Cannot contain a Q or Z

 You cannot reuse your last four passcodes

 No 3 character months JAN, FEB are restricted

 No sequence of numbers or characters 1234 4321 ABCD

 Cannot repeat one character more than two times (for example.
AA is allowed, AAA is not allowed)

 Cannot use standard words or proper names (for example.
DALLAS or FROG are not acceptable)

 You receive this error response CONTAINS RESTRICTED WORD -
NEW PASSCODE UNACCEPTABLE
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D U T Y C O D E S

Note: Duty codes are system access rights that determine the range of functions that an agent can perform in the Sabre system. These are stored in
your EPR and vary according to an agent’s duties.

If your EPR allows it, you can also switch duty codes, when necessary, in order to perform different functions.

The three duty codes, along with the access rights provided by each, are:

 * - Allows agent full reservations access for normal Sabre system activity
 9 – Allows agent supervisory and managerial access for those responsible for management functions

 6 – Allows agent to access the training mode, providing the ability to practice without impacting actual customer records

W O R K A R E A S

The Sabre system has six work areas, identified as A, B, C, D, E, and F. You sign in to all six of these system work areas by entering an asterisk (*)
prior to your identification number as follows.

S I G N I N F O R M A T

Step 1: Type SI* followed by your agent identification number SI*(identification number)
SI*000000

System Response:

AGENT SIGN IN

CURRENT PASSCODE ID <000000> SUF <PCC0 >

DUTY CODE <.> AREA <*> NEW PASSCODE

Component Description

CURRENT PASSCODE Type your current passcode (it will not appear when typed)

ID Reflects agent identification number

SUF Reflects agency pseudo city code (PCC)

DUTY CODE Reflects duty code or level of access

AREA Reflects the area to be signed in

NEW PASSCODE Area where you can change your passcode

Step 2: Type your passcode in the sign-in mask
(passcode)
PASSWRD1

Signing into the Sabre System Quick Reference Page | 2
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S I G N I N S Y S T E M R E S P O N S E

Your Active pseudo city
code (dot) your Agency
home pseudo city code

PCC0.PCC0*ALJ....A.B.C.D.E.F
19JUN
** SABRE EXCLUSIVES *SA* LOWEST AVAILABLE HOTEL RATES

2-5 STAR HOTELS 10PCT COMM GUARANTEED WITHIN 2 WEEKS
**INTER-CONTINENTAL *THE WHOLE WORLD-HALF OFF* SUMMER**

SALE INCL BKFAST AT PARTICIPATING HOTELS -HODIC/HOT

Current date Your duty Your The work areas signed in Sign in message
code individual

agent sign
 The active area

displays first

 The system places
you in work area A
to begin

 Messages may be created by the
Sabre system or your local agency

 May be redisplayed after the sign in
response has been cleared from
screen

S I G N O U T F O R M A T

The Sabre system tracks all entries by agent sign. When you are through working in the system, you should sign out to prevent other individuals from
making entries using your passcode.

Sign out of the current work area SO

System Response:

B SIGNED OUT
Sign out of all work areas SO*

System Response:

A.B.C.D.E.F..SIGNED OUT

W O R K I N G W I T H W O R K A R E A S F O R M A T

When you leave a work area, it becomes inactive until you return to it. Entries made in the active area do not affect the work you do in another area.
When you return to an area you previously left, that area becomes active again.

Note: All items to be recorded in a single Passenger Name Record (PNR) should be completed in the same work area.

Change to a different work area: A,B,C,D,E, or F ¤(work area letter)
¤D

System Response:

PCC0.PCC0*ALJ..D

Display current work area *S

System Response:

PCC0.PCC0*ALJ..D

Display the status of all work areas *S*

System Response:

PCC0.PCC0*ALJ.A..PNR PRESENT
ACTIVE AGENT – L JONES - 000000-PCC0
PCC0.PCC0*ALJ.B..PNR PRESENT
PCC0.PCC0*ALJ.C..PNR PRESENT
PCC0.PCC0*ALJ.D..
PCC0.PCC0*ALJ.E..
PCC0.PCC0*ALJ.F..
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Display the status of all work areas, along with assigned printers *S*P

System Response:

PCC0.PCC0*ALJ.A..PNR PRESENT
ACTIVE AGENT – L JONES - 000000-PCC0
H1-AB123C AT T-AB123D I-AB123E
PCC0.PCC0*ALJ.B
H1-AB123C AT T-AB123D I-AB123E
PCC0.PCC0*ALJ.C
NO PRINTERS
PCC0.PCC0*ALJ.D
NO PRINTERS
PCC0.PCC0*ALJ.E
NO PRINTERS
PCC0.PCC0*ALJ.F
NO PRINTERS

Redisplay the sign in message S/*

System Response

PCC0.PCC0*ALJ..B..PNR PRESENT
19JUN
**SABRE EXCLUSIVES *SA*.LOWEST AVAILABLE HOTEL RATES**

2-5 STAR HOTELS 10PCT COMM GUARANTEED WITHIN 2 WEEKS
**INTER-CONTINENTAL- *THE WHOLE WORLD-HALF OFF* SUMMER*

SALE INCL BKFAST AT PARTICIPATING HOTELS -HODIC/HOT

S W I T C H D U T Y C O D E S F O R M A T

When you sign in to the Sabre system, the duty code defaults to *. However, some entries require that you sign into the Sabre system using a special
duty code. You can activate an assigned duty code without signing out and signing back in.

Change duty code

Note: This format activates duty codes that already exist in your
Employee Profile Record (EPR); it does not update or change your EPR.

SI(duty code)
SI9

System Response

PCC0.PCC09A
LJ..A..*ALJ
.NOT SIGNED
OUT

A
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Sabre Red Workspace
O V E R V I E W

The Sabre® Red™ Workspace is an agent booking portal built on a platform that is focused on delivering the greatest experience for you through
optimized technology. Sabre Red Workspace offers you great features and functionalities increasing your effectiveness and efficiency with clients.

Greater Experience

Improved interaction between multiple applications and Web pages enables you to move between Sabre Red Workspace sessions and Web pages
without having to spend the time refreshing content.

Sabre Red Workspace includes an application launching bar which allows you to embed your commonly used applications or Web pages. You can
integrate internal agency sites, email, and commonly used web sites into Sabre Red Workspace.

Greater Performance

Because much of the Sabre Red Workspace application will live on your desktop, you will experience faster loading times as it does not load over the
Internet. In addition, when you sign into Sabre Red Workspace, the Sabre system work area loads prior to checking for updates. You will see
greater stability since much of the heavy processing will occur on the desktop side instead of on the server side. This will require a lot less reliance
on Internet connectivity and speed.

The architecture on which Sabre Red Workspace is built on is inherently modular, which enables component based delivery. This allows Sabre to
deliver updates for only altered or changed code, as opposed to delivering the entire application every time there is a change. This really cuts down
on the amount of bandwidth required and time to implement any updates.

Greater Control

Your agency administrator for Sabre Red Workspace can create a customized version of Sabre Red Workspace for each agent in your office by
turning features on or off depending on such things as the type of travel you handle or your geographic location. Once features are turned off, you
will not receive updates to that piece of your Sabre Red Workspace application unless you turn that feature back on.

When an update is available, you will log in and begin working before the system even begins checking for that update. Once the system finds an
update, the download will occur in the background and will not require the immediate restart of Sabre Red Workspace which means you can continue
to work. Your agency administrator can also control the timing of these update deliveries.

So, welcome to Sabre Red Workspace!

Use this document to acquaint yourself with the look and feel of Sabre Red Workspace. It will guide you in locating all of the tools you are familiar
with, as well as all of the new features and tools of Sabre Red Workspace.

Navigating Sabre Red Workspace Quick Reference Page | 1
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S A B R E R E D W O R K S P A C E D E S K T O P

The Sabre Red Workspace desktop is structured into three main areas. Within each area, you may have multiple bars, areas, or tabs to facilitate the
servicing of your client.

1. Menu area

2. Application area with tabs

3. Status area

Menu
Bar

1
Tool Bar

Application
Launcher Bar

Application
Side Bar

Sabre Work Area

2

3

Note: you will only see applications and content that is applicable to your region.

Navigating Sabre Red Workspace Quick Reference Page | 2
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M E N U A R E A

The Menu area contains standard menu categories, such as File, Edit, View, Tools, Window, Help, and Contact Us. Applications may also appear
under Tools, Community, or Admin.

Favorites Favorites allows you to customize your favorites by adding up to
15 frequently used applications to the list of Favorites. You can
also see a list of Recent History with the applications added to the
Favorites list. You can remove items at any time as well as clear
the Recent History.

Tools Tools contains links to the various applications and booking tools
you use in your day-to-day work flow while servicing your clients’
travel needs.

Note: you will only see applications and content that is applicable
to your region.

Community Community contains links to items such as Agency eServices,
Red App Centre, AgentStream travel agent community,
Sabre® Traveler Security, and QuickNews blog.

AgentStream® travel agent community is an interactive agency
community where you can talk about your issues with other Sabre
ConnectedSM agents, ask questions, and share your knowledge
and expertise with other agents.

Note: AgentStream is currently only available in North America.
Geographic expansion is under evaluation.

Admin Admin contains links to Help Desk and Blueprint Tools

File The File menu contains commands relating to the handling of files,
such as open, save, close, print, etc.

The Exit Sabre Red Workspace command is located in this
menu.

Note: commands on the menu may change based on the tasks
you are completing.

Edit The Edit menu contains commands relating to the handling of
information, i.e. cut and paste and selection commands. Use the
Rename Area command to customize the name of the work area
tabs.

Note: commands on the menu may change based on the tasks
you are completing.

Navigating Sabre Red Workspace Quick Reference Page | 3
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View The View menu contains commands relating to how you view
content in Sabre Red Workspace. It contains links to customize
your screen layout, change from Full to Split screen and vice
versa, open and close the Command Line or Memo Area fields,
and specify either the Long or Short display.

The Connection Details command provides information on your
connection to the Sabre® system and to Web Services servers.

Note: commands on the menu may change based on the tasks
you are completing.

Customize Screen Layout command
(on the View menu)

The Customize Screen Layout command provides you the ability
to change your default single screen layout to one of the three
predefined multiple screen layouts.

Click OK.

Tools The Tools menu contains commands relating to the various tools
and applications you have available in Sabre Red Workspace.

The Sabre Keys command provides you a list of the most
common commands with its equivalent keyboard key combination.

Note: commands on the menu may change based on the tasks
you are completing.

Agency Applications command
(on the Tools menu)

Clicking Agency Applications on the Tools menu displays the
Options window.

You can add links to other applications, such as MS Word, MS
Excel, or MS Outlook, etc. These links then appear on the Tool
Bar.

Click Add.

Type the name of the application.

Click Browse and locate the executable file for the application.

Click OK.

Options
(on the Tools menu)

You can customize your Sabre Red Workspace experience using
the Options window.

Navigating Sabre Red Workspace Quick Reference Page | 4
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Click Agent Profile To modify the information stored in your Sabre Red Workspace
profile.

Click Sabre System To add or remove settings pertaining to the Sabre system.
Examples include: accumulated response, bold font, Point & Click
highlighting and tool tips, Graphical Seat Map, cursor type, etc.

Click Appearance To establish your Sabre system color preferences for either all or
individual Sabre work areas, Sabre screen font size, or
SabreScribe screen font size.

Click General Settings To select your preferred language.

Click Agency Applications To configure access to frequently used applications.

Click Toolbar To display or hide labels for the Toolbar icons.

Click Favorites
(under Toolbar)

To add or remove Sabre Red Workspace application shortcuts to
the Toolbar.

Click Password Management To establish or modify the Security Questions and your E-mail
Address associated with your password.

This area is locked. To unlock it, click the Lock icon, and provide
your Sabre Red Workspace login credentials.

Click New Password To change your password.

This area may be locked. To unlock it, click the Lock icon, and
provide your Sabre Red Workspace login credentials.

Click AgentWare Profile
(under NetCheck Profile)

To create or modify your AgentWare Profile or to add or remove
airline providers (North America).

Click TravelFusion Profile
(under NetCheck Profile)

To add or remove airline providers (Europe, Middle East & Africa).

Window The Windows menu contains links to all active work areas.

Note: commands on the menu may change based on the tasks
you are completing.

Help The Help menu contains commands for checking for Sabre Red
Workspace software updates, history of software updates, Help
documentation, etc.

Note: commands on the menu may change based on the tasks
you are completing.

Navigating Sabre Red Workspace Quick Reference Page | 5
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A P P L I C A T I O N A R E A

Application
Shortcuts

Agency Application
Shortcuts

Work
area tabs

Booking Tools and
Application
Shortcuts

Work Areas Sabre Red Workspace provides a separate tab for each of the Sabre system work areas – A through F –
allowing you to quickly switch from one work area to another.

Click the desired tab to switch to the work area. Or, use CTRL + Tab to move through work area tabs from left
to right. Or, use CTRL + Shift + Tab to move through work area tabs from right to left.

Click X on the tab to close the work area, if desired.

Click New Sabre Area to add a work area tab (maximum of 6 – A through F).

You can also merge your work area tabs into a single tab. Go to Tools > Options > Sabre System and select
Use Single Tab under Work Area Management.

You now must use ¤B, ¤C, ¤D, etc. in the blue screen to move between areas. The current work area is
bracketed in the tab.

Full / Split These buttons provide the ability to see your Sabre work area as a single screen or split into two screens.

Navigating Sabre Red Workspace Quick Reference Page | 6
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Assistant
Tools

Application Shortcuts These are links for Application Shortcuts you selected in the Options menu under General Settings > Toolbar >
Workspace Applications.

Agency Application Shortcuts These are links for Agency Application Shortcuts you selected in the Options menu under General Settings >
Agency Applications.

Booking Tools and Applications As you access tools and applications under Tools, Community, or Admin you add a tab for each of those tools
or applications. This allows you to easily move among the various tools and applications you have open.

You can rearrange work area, booking tools, or application tabs by dragging the tab into the desired position
with your mouse pointer.

When you fill all of the viewable area on the tool bar, you will see an indicator at the right as to how many
additional tools and applications you have open. Click the indicator to view the list and select a tool or
application.

Assistant Tool Panel Depending on the tool, it will display in either the Vertical Assistant Tool Panel or the Horizontal Assistant
Tool Panel.

Application
Side Bar

Assistant
Tool

SliderBar

Vertical Assistant
Tool Panel

Navigating Sabre Red Workspace Quick Reference Page | 7
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Application
Side Bar

SliderBar Assistant
Tools

Horizontal
Assistant Tool
Panel

Use your mouse to drag the Slider Bar to adjust the width of the Vertical Assistant Tool Panel or the height of
the Horizontal Assistant Tool Panel.

Tools remain active in the Application Side Bar so it is not necessary to reload them each time you switch back
to a previously used tool.

Active Tools are highlighted and italicized, such as Point & Click and Encode/Decode in the graphic above.

Use the scroll bar on the Application Side bar to see all available tools.

Note: Currently, you may see the scroll bar only if your browser is not maximized.

A C T I V E A S S I S T A N T T O O L S

Point & Click Access to enable navigation in the Sabre system using the mouse to reduce keystrokes. Applicable for Air,
Hotel and Car functions.

PNR Services Access to send OSI and SSR messages to airlines in the itinerary. Options include Meals, Assistance,
Wheelchair requests, OSI, Frequent Traveler information, and Paid Seats.

Smart Search Integrated search within the Sabre Red Workspace.

Encode/Decode Access for assistance on all travel industry codes.

Email Proposal Send a trip proposal to your customer

Format Finder Access for quick and reliable help on Sabre system commands.

Graphical Ticketing Access for a graphical tool that facilitates pricing, storing fares and FP lines, issuing and printing tickets, and
invoices and itineraries.

Sabre Travel Protection Access to provide travel insurance to your customers.
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Quick & PF Keys Access frequently repeatable entries stored in your Quick Keys and PF Keys. Record and Edit Quick Keys.
Edit PF Keys.

Sabre Scripts Access the Open SabreScript window to select and activate the desired scripts.

Click the name of a script to view a short description.

Documents & Messaging Provides personalized travel information.

Today’s Low Fares Quick access to low fares for up to 10 city pairs.

Travel Protection Access to sell trip cancellation, baggage and medical insurance.

A G E N T N O T I F I C A T I O N S

Informational and operational notification messages appear once Sabre Red
Workspace is opened on your desktop. You will see them in the lower right
corner of the Sabre system work area.

Click More to read the complete notification message now or you can read it
later.

Notifications will automatically fade after 30 seconds.

The Unread Notifications Indicator is located on the status bar.

Click the Unread Notifications Indicator to view a list of unread notifications.
Unread message titles appear in bold text.

Click the name of the Notification to open it.

If there are no unread notification messages, the indicator will reflect 0 (zero).

Unread
Notifications
indicator

Click OK to close the notification message window.

You can continue to retrieve or read old messages by clicking on the
Notifications Indicator.

E X I T I N G S A B R E R E D W O R K S P A C E

When you click Exit Sabre Red Workspace in the File menu, or close Sabre Red Workspace using the browser exit  button, you will see a warning
message asking you to verify that you want to exit Sabre Red Workspace. Included is a reminder to finish all of your PNRs and to sign out of the
Sabre system before you close Sabre Red Workspace.

This should eliminate error messages the next time you access and log in to Sabre Red Workspace, as well as accidentally leaving any unfinished
PNRs in your work areas.
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Using the Memo Area
Quick Reference

O V E R V I E W

The Memo Area provides a section of the Sabre Work Area where you can temporarily place information for viewing. You can use the Memo Area as
a note pad to record pieces of information that may be needed later in making a reservation. It may be especially helpful when you have information
that is needed in multiple reservations. The Memo Area is not an active work area in the system and is used only to store information. Text in the
Memo Area of the screen will not inhibit any functionality.

D I S P L A Y T H E M E M O A R E A

The Memo Area option on the “View” menu toggles the Memo Area
between being visible and not visible. When “Memo Area” is preceded by
a checkmark, it is active and will be visible.

 Click View to display the “View” menu (Alt-V)

 Click Memo Area to active or deactivate the Memo Area option
(M)

Note: You can still send information to the Memo Area even when it is
not visible. Then when the Memo Area is active, you will see the
information you stored there earlier

P L A C I N G T E X T I N T H E M E M O A R E A

The Memo Area appears close to the top of the Sabre Work Area below
the menu bar. You can type on the Memo Area or:

 Type the text in the Sabre Work Area

 Press the Memo (End) key to place text in the Work Area.

A scroll bar at the right of the Memo Area, allows you to scroll through
the information you have placed in this area.

Information will remain in the Sabre Work Area until it is removed.
Clearing the Work Area does not erase text from the Memo Area.
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E R A S E T H E M E M O A R E A

To erase the text from the Memo Area only press Alt+Memo

(Alt+End) To clear the text from the Sabre Work Area only press

Alt+Backspace

To clear both the text from the Memo Area and the Sabre Work Area press Ctrl+Backspace

Using the Memo Area Quick Reference Page | 2
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Basic PNR
Quick Reference

F I V E M A N D A T O R Y C O M P O N E N T S F O R M A T

PNR is an acronym for Passenger Name Record. It contains all the information necessary for your client’s reservation. You must complete
five required fields in a PNR before you END the reservation. You can complete the fields in any order. To remember these fields, you may
use the keyword PRINT:

P- Phone field  R- Received From field I- Itinerary field N- Name field T- Ticketing Time Limit field (T)

Enter the phone field
9(area code)-(prefix)-(number)-(identifier)
9080-955-6610-A

Enter the received from field
6(name)
6DORIS

Complete the itinerary field:

Step 1: Display availability

Step 2: Book the flight

1(date)(city pair)
124JUNLOSLON

0(number of people)(class of service)(line number)
03Y1

Enter the passenger name -(last name)/(first name)(middle name)
-ADAMS/OBI OLU

Enter the ticketing time limit field. Automatically place the PNR on
Queue 9 (ticketing queue) on specified date.

7TAW(ticket date)/
7TAW11JUN/

End transaction E
E

I N F A N T N A M E

Use the infant name field only to identify an infant who is not occupying a seat. An infant is a child under two years.

It is required that you add an SSR.

Add single infant name field -I/ (last name)/(first name)
-I/ADAMS/MARY

Add multiple infant names -I/(number of infants)(last name)/(first name)/(first name)/(first
name)
-I/3OBI/MARY/JUNE/BRANDON
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A D D S S R – S P E C I F Y I N F A N T N O T
O C C U P Y I N G A S E A T

On all segments and traveling with more than one adult - add
infant's date of birth:

3INFT/ANDY/MARY/09JAN11-1.1

On all segments and traveling on American Airlines with one or 4INFT/ANDY/MARY/09JAN11-1.1
more adults

E X A M P L E O F B A S I C P N R F O R M A T

1.2MURRAY/FRED MR/HANA MRS     2.1SMITH/JUNE
1 IB6840F 24JUN 1 LOSMAD HK3   1510  0645 25 JUN 2 /DCIB*YJXMIB /E
2 IB3500C 25JUN 2 MADLOS HK3   0905  1140 /DCIB*YJXMIB /E

TKT/TIME LIMIT
1.TAW11JUN/

PHONES
1.LOS080-955-6610-A

RECEIVED FROM - DORIS
A0UC.A0UC*ASC 1054/29NOV07 VZRAFH

Name field

Itinerary field

Ticketing field

Phone field

Received from field

Sabre PNR

Signature line:

A0UC.A0UC Current Pseudo City Code. Home Pseudo City Code

* Active Duty Code

ASC Agent Sign (A=Agency SC=Agent initials)

1054/29NOV07 Time/Date PNR was created

VZRAFH PNR Sabre Record Locator

A D D I T I O N A L I N F O R M A T I O N

Find more information in Format Finder

Refer to other quick references in Agency eServices to find more information on:

 TripCase

 Passenger Association

 PNR Optional Fields

 Secure Flight

Basic PNR Quick Reference Page | 2
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City Pair Availability
Quick Reference

D I S P L A Y A I R A V A I L A B I L I T Y F O R M A T

Use the air availability formats to search for flights and determine what space is available for your passenger.

 You can request availability up to 331 days in advance for most carriers. Some carriers display inventory and accept bookings up to
363 days in advance.

 Depending on airlines’ participation you can display availability from two different sources:

 Sabre® system availability (using Sabre Direct Connect Availability DCA or Sabre system availability DC)

 Airline’s availability (using Direct Access airline response)

Display basic City Pair Availability (CPA)

Note: Sabre will assume current day if you omit the departure date

1(departure date)(departure city)(arrival city)
123JUNLOSLON

1LOSLAX

Display availability by departure time or departure time range

Note: The Sabre system default is 1:00PM.

1(travel date)(departure city)(arrival city)(departure time)
123JUNLOSDXB9A

123JUNLOSACC700-900

Display Sabre system availability with preferred airline

Note: Specify a maximum of 20 airlines

1(travel date)(departure city)(arrival city)¥(airline code)
123JUNLOSIAH¥UA

123JUNLOSNYC¥UADLBA

Display availability with preferred airline bypassing the Sabre
response and showing the Direct Access airline response

1(travel date)(departure city)(arrival city)¤(airline code)
123JUNLOSLON¤UA

Specify connecting city 1(date)(city pair)(time)(city code)
128SEPLOSORD13DEN

Availability specifying a class of service 1(date)(city pair)(time)-(class of service)
123JUNLOSACC10-K

Availability specifying direct flights 1(date)(city pair)(time)/D
123SEPLOSJNB2030/D

Subtract specific number of days to availability display 1-(number of days)
1-5

Display return availability for a new date 1R(new date)
1R25JUN

Display return availability adding specified number of days 1R¥(number of days added to availability)
1R¥15

Request additional flight availability 1*

Request to view all flights with all classes of service 1*C

Note: Use this format when you need to request a class of service
that does not appear in the first availability response
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A I R A V A I L A B I L I T Y R E S P O N S E

125FEBLOSLON1P«
25FEB  THU   LOS/Z‡1     LON/-1
1W3     101 J9 C9 D9 LOSLHR 1245 1830   332 0 DC /E

P9 A9 I9 Y9 S9 B9 H9 K9 L9 M9 O9 Q9 T9 U9 V9 X9 N9
2VS     652 J9 C9 D9 LOSLHR 1100 1655   333 L 0 DCA /E

I9 Z5 W9 S9 H9 K9 Y9 B9 R9 L9 U9 M9 E9 Q0 X0 V0 N0 O0
3BA      74 F9 A9 J9 LOSLHR 2330 0500‡1 744 M 0 DCA /E

C9 D9 R9 I9 W9 E9 T9 Y9 B9 H9 K9 M9 L9 V9 S9 N9 Q9 O9 GL
4AT     554 J9 C8 D6 LOSCMN 0625 1000   738 B/B 0 X235 DCA /E

Y9 B9 M9 Q9 O9 K9 H9 T9 V9 X1 U9 L7 R9 WC PC SC GC
5AT     802 J9 C3 D3 LGW 1110 1425   738 D/D 0 457 DCA /E

Y9 B9 M9 Q9 O9 K9 H9 T9 V9 X9 U9 L1 R1 WC PC SC GC
SEE JM*1 *FI* FRASERS HOSPITALITY **COMP WIFI**.

Important Notes:

Each display line of air availability may contain the following information:

LOS: Originating city followed by time zone indicator
and time difference respect to GMT (Greenwich
Mean Time or Zulu time); LHR: Destination airport
and time difference between the arrival and
destination time zones. Note: This information
varies with each city.

SEE JM*1 is an advertisement

 W3 101: Airline code and flight number. Both marketing and operating carriers are indicated for Code-sharing flights

 The carrier after the slash / can also appear as ** (AT/**) if the operating carrier is unknown

 J9 D9 Y9…Classes of Services offered and the maximum number of seats you can book in one entry

 LOSLHR: Airport codes of the city pair

 12451830: Local times of Departure and Arrival

 744: Type of aircraft or equipment for this flight

 B/B: Meal service offered on board

 0: Number of Stops of the flight

 X235: Day of service indicator. (Except Tuesday, Wednesday, and Friday)

 DCA: Code for the connectivity level of participation of the airline
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A I R A V A I L A B I L I T Y R E S P O N S E W I T H
W A I T L I S T D E T A I L S A C T I V A T E D

F O R M A T

Display air availability using the same air availability formats you
have learnt

1(departure date)(departure city)(arrival city)
112DECLOSLON

12DEC SAT   LOS/Z‡1     LON/-1
1VS 652 J3 C3 D3 I3 LOSLHR 1100 1655   346 L 0 DCA /E

Z0 W6 S5 H5 K4 Y9 B9 R9 L9 U9 M9 E9 Q9 X9 V0 N0 O0
2W3 101 J9 C9 D9 P9 LOSLHR 1245 1830   332 0 DC /E

AC IC Y9 S9 B9 H9 K9 L9 M9 O9 QL TR UC VC XC NC
3BA   74 F7 A5 J9 C6 LOSLHR 2330 0500‡1 744 M 0 DCA /E

D2 RC IC W9 E5 TC Y9 B9 H9 K9 M9 L9 V9 S9 NC QC OC GL
4AT 554 J9 C8 D5 Y9 LOSCMN 0625 1000   738 B/B 0 X2 DCA /E

B9 M9 Q9 O9 K9 H9 TC V1 X6 UC LC RC WC PC SC GC
5AT 800 J8 C1 D1 Y9    LHR 1230 1550   738 D/D 0 DCA /E

B9 M9 Q9 O9 K9 H9 TC VC XC UC LC RC WC PC SC GC
6AT 554 J9 C8 D5 Y9 LOSCMN 0625 1000   738 B/B 0 X2 DCA /E

B9 M9 Q9 O9 K9 H9 TC V1 X6 UC LC RC WC PC SC GC
7AT 804 J8 CL D2 Y9    LHR 1455 1815   738 D/D 0 256 DCA /E

B9 M9 Q9 O9 K9 H9 T9 VC XC UC LC RC WC PC SC GC
8W3 388 J9 C9 D9 PL LOSACC 2045 2045   73G 0 246 DC /E

AL IL Y9 S9 B9 H9 K9 L9 M9 O9 QL TL UL VL XL NL
9BA   78 F9 A8 J9 C9    LHR 2240 0505‡1 744 M 0 6 DCA /E

D9 R9 I5 W9 E9 T3 Y9 B9 H9 K9 M9 L9 V9 S9 N9 QC O9 G9
10AF 3849 J2 C2 D2 IC LOSCDG 2355 0620‡1 332 BM 0 DCA /E

ZC OC W6 S6 A4 Y9 B8 M7 U4 K4 HC LC QC TC EC NC RC VC
XC GR

11AF 1680 J2 C2 D2 IC    LHR 0725 0745   321 B 0 DCA /E
ZL OC W6 S6 A4 Y9 B8 M7 U4 K4 HC LC QC TC EC NC RC VC
XC GR

SEE JM*1 922*JUMEIRAH CARLTON TOWER*30 PC OFF BAR FOR 3 NIGHTS
SEE JM*2 TM841 *BELGRAVES* 20 PC DISC* CONTL BKFST* FREE WIFI.

Waitlist Status indicators:

 R - Flight closed – Request Only: means the flight can be requested as “NN”

 L - Flight closed – Waitlist Open: means the flight can be waitlisted as “LL”

 C – Flight closed – Waitlist closed

 0 – Flight closed – Waitlist unknown

City Pair Availability Quick Reference Page | 3
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A V A I L A B I L T Y B Y C A B I N

City Pair availability provides the ability to search and display availability in the Sabre system by cabin. It allows to search exclusively by
specific cabin type, or to search availability excluding specific cabin types.

Cabins included in this enhancement:

 FB - First

 BB - Business

 YB - Economy

 SB - Premium economy

 PB - Premium First

 JB – Premium Business

Display availability including specific cabin

Notes:

1(date)(citypair)//(cabin)
130JUNLOSFRA//FB

 the cabin request qualifier has two slashes (//) followed by
two alpha characters for the cabin code.

 This qualifier may be added to all CPA formats (except for
the Class Specific qualifier). You cannot combine class
specific request with Cabin request.

 This qualifier can be used before or after the carrier
specification, should there be one

1(date)(city pair)(time)//(cabin)¥(airline)
19DECLOSATL6P//PB¥DL

1(date)(city pair)/(time)¥(airline)//*(cabin exclusion)
19DECLOSATL/6P¥DL//*PB

Display existing availability request including a different cabin 1//(Cabin)
1//SB

Display availability including a specific cabin, specifying departing
time

1(date)(city pair)(time)//(cabin)
19DECLOSMIA6P//PB

Display availability including a specific cabin, specifying time and
one connecting city

1(date)(city pair)(time)(connecting city)//(cabin)
19DECLOSLAX6PDFW//PB

Display availability including specific cabin, specifying time and
multiple airlines

1(date)(city pair)(time)//(cabin)¥(airline)(airline)(airline)
19DECLOSMIA6P//PB≠DLUAAA

Display availability excluding specific cabins 1(date)(city pair)//*(cabin exclusion)
130JUNLOSFRA//*BBFB

Display existing availability request excluding specific cabin or
cabins

1//*(cabin exclusion)
1//*BBYB

Display availability excluding a specific cabin and specifying
departure time

1(date)(city pair)(time)//*(cabin exclusion)
19DECLOSLON6P//*YB

Display availability excluding a specific cabin, specifying departure
time and connecting city

1(date)(city pair)(time)(connecting city)//(cabin exclusion)
19DECLOSMIA6PDFW//*PB

Display availability excluding a specific cabin, specifying arrival time,
connecting city and desired airline

1(date)(city pair)/(time)¥(airline)//*(cabin exclusion)
19DECLOSLON/6P¥BA//*YB
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Display availability excluding a specific cabin and specifying
departure time, connecting city and multiple airlines

1(date)(city pair)(time)¥(airline)(airline)(airline)//*(cabin exclusion)
19DECLOSMIA6P¥DLUABA//*SB

F L I G H T I N F O R M A T I O N F O R M A T

Verify flight information from one line of an availability display. Get
details on departure and arrival time and date, meals, equipment,
elapsed flying time, mileage, etc.

Note: Type: DU*/MLS to decode meals

Verify flight information from more than one line of an availability
display.

VA*(CPA line number)
VA*2

Example:
23DEC FLT SEGMENT DPTR ARVL   MEALS    EQP ELPD MILES SM
2 BA   74 LOS LHR 2330 0500 ‡ M        744 6.30 3099 N

DEP-INTERNATIONAL TERMINAL     ARR-TERMINAL 5
ONEWORLD ALLIANCE.VA*(segment number)-(segment number)
VA*3-5 or VA*3/5

Verify flight information with a flight number

Note: This format displays also the accumulated flying time.

V*(carrier)(flight number)/(date)
V*BA74/14FEB

E F E R E N C E S

City Pair Availability Quick Reference Page | 5
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Selling Air Reservations
Quick Reference

C R E A T I N G I T I N E R A R I E S

The itinerary field of a Passenger Name Record (PNR) holds the actual bookings. It can include air, car, hotel, and auxiliary bookings. There is a
maximum of 99 itinerary items allowed per PNR. The formats below correspond to air segments only.

S E L L F R O M C I T Y P A I R A V A I L A B I L I T Y F O R M A T

Sell flight from city pair availability (CPA) 0(nbr of seats)(class of service)(CPA line nbr)
01Y1

Sell flight from availability and the connecting flight on the following line(s) with
the same class of service.

0(nbr of seats)(class of service)(CPA line nbr)*
01Y1*

Sell flight from availability and the connecting flight on the following line(s) in
different requested class of service.

0(nbr of seats)(class of service)(CPA line nbr)(class of
service)(CPA line nbr)
01Y1F2

Waitlist flight from availability 0(number of seats)(class of service)(CPA line nbr)LL
01Y1LL

Waitlist flight from availability and the connecting flight on the following line(s)
with the same class of service.

0(number of seats)(class of service)(first line number of
connection)LL*
01Y1LL*

Waitlist flight from availability and the connecting flight on the following line(s)
in different requested class of service.

0(number of seats)(class of service)(CPA line nbr) (class of
service)(CPA line nbr)LL
01Y2K3LL

L O N G S E L L F O R M A T

You are able to manually enter an agent sine in the long sell and change segment status for only the following status codes: BK, BL, DS, GK, GL,
HK, HL, YK.

Long sell a flight by flight number without previously displaying a CPA. 0(carrier code)(flight number)(class of service)(date) (city pair)
NN(number of seats)
0BA074Y14FEBLOSLHRNN2

Waitlist a flight by flight number without previously displaying a CPA. 0(carrier code)(flight number)(class of service)(date) (city pair)
LL(number of seats)
0VS651Y6OCTLHRLOSLL1

Sell open segment 0(carrier code)OPEN(class of service)(date)(city pair)DS(number
of seats)
0AFOPENJ9JULLOSCDGDS2
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1 KL 588L 20DEC 7 LODAMS* 1/1
SS1

2305 0550 /DCKL
2 KL1421L 21DEC 1 AMSBHX* 1/2

SS1
0825 0840 /DCKL

3 AF1422M 02NOV 3 BHXAMS* 2/1
SS1

0635 0905 /DCAF
4 KL 601M 02NOV 3 AMSLAX* 2/2 1135 1755/DCKL

P A S S I V E B O O K I N G F O R M A T

Enter a flight you have confirmed directly with the airline using GK or BK 0(carrier code)(flight number)(class of service)(date) (city pair)
(status code)(number of seats)*(optional airline record locator)

0VS651Y6OCTLHRLOS GK1*AB123C

C H A N G E S E G M E N T S T A T U S F O R M A T

Change segment status.

Note: You are able to enter an agent sine only for the following status codes:
BK, BL, DS, GK, GL, HK, HL, YK

.1(status code)

.1BK

E X A M P L E S O L D S E G M E N T

01Y1«
2 BA 192Y 23NOV S DFWLHR SS1   520P  800A  24NOV M/E

Notes:

 • 2: Segment number in the itinerary of the record

 • BA: Two-letter carrier code

 • 192Y: Flight Number sold and Class of Service

 • 23 NOV: Date of the originating flight

 • S: Day of the week of the departing flight

 • DFWLHR: Departure and arrival cities associated with the flight number you are booking

 • SS1: Status/Action code SS (Seats Sold) returned by the airline as a result of your sell message. The number of seats sold, 1,
corresponds to the number of names in the record excluding infants

 • 520P: Departure time from the originating city

 • 0800A: Local time the flight arrives at the destination

 • 24NOV M: If the flight you requested undergoes a date change enroute, the response will include the new date of arrival and day of the
week indicator.

 • /E Electronic ticket eligible

Note: See Format Finder online help system for a complete explanation of each component in this display

M A R R I E D S E G M E N T S F O R M A T

Direct Connect Availability carriers may select to participate in the Sabre Married Segments feature. Married Segments give the participating carriers
the opportunity to maintain their inventory based on the market flown rather than point to point. The carrier returns marriage indicators for applicable
segments after the sell. An asterisk indicates the married group. Type Married Segments on the Format Finder search bar for complete information
about Married Segments

All participating carriers except for American Airlines return the * indicator next
to each arriving city:

1 KL 588L 20DEC 7 LOSAMS*SS1  2305  0550   21DEC 1 /DCKL /E
2 KL1421L 21DEC 1 AMSBHX*SS1  0825  0840  /DCKL /E
3 AF5019H 30DEC 3 BHXCDG*SS1  0635  0905  /DCAF /E
4 AF3832H 30DEC 3 CDGLOS*SS1  1135  1755  /DCAF /E
Display married segment connection details for all participating carriers except
American Airlines.

Note: The first number indicates the married group, and the number after the
slash indicates the segment sequence within that group.

American Airlines returns the “*” indicator in front of the departing
city and after the destination city to designate Married Segments:

1 AA2448Y 25NOV W*LAXDFW SS1 125P 630P /DCAA /E
2 AA 78Y 25NOV W DFWLHR*SS1 725P 1035A 26NOV/DCAA/E

 *IMSL
*IMSL«
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I T I N E R A R Y S E Q U E N C E

Itinerary segments must be in date and city sequence, and they should have continuity. The following two sections describe the formats that will help
you fix the segment order before pricing and ticketing the record

S E L L A S U R F A C E ( A R N K ) S E G M E N T F O R M A T

Enter a surface (ARNK) segment to represent arrival unknown when an itinerary is not in continuity. For example: You fly from LHR to MIA but your
return flight is from MCO to LHR. Your arrival to MCO is unknown by the system.

Insert a surface (ARNK) segment. 0A

Automatically insert ARNK segment(s) where discontinuity occurs. 0AA

I N S E R T A N D M O V E I T I N E R A R Y S E G M E N T S

The Automatic Segment Arrangement allows all new air segments sold to be arranged automatically by date, board and off point, and departure
time, if it is set to ON in your agency’s Travel Journal Record (TJR). Display your agency’s TJR (W/TA*pseudo city code) and see AUTOMATIC
SEGMENT ARRANGE-ON. If this option is not available in your agency use the formats below to manually inserting and moving itinerary segments.

Insert and sell from city pair availability in one entry. /(segment number to insert after)/0(number of seats)(class of
service)(line number)
/1/02Y1

Insert segment at the beginning of an itinerary.

Note: To insert before segment 1, use 0 as the number to insert after.

/0/0(number of seats)(class of service)(line number)
/0/02Y1

Insert and sell by flight number in one entry. /(segment number to insert after)/0(carrier code) (flight
number)(class of service)(date)(city pair)NN(number of seats)
/1/0AR82Y8DECEZEJFKNN1

Insert arrival unknown (ARNK) segment. /(segment number to insert after)
A/2A

Move segment to different position in itinerary. /(segment to insert after)/(segment to be moved)
/1/4

Move a range of segments to a different position. /(segment to insert after)/(segment number)-(segment number)
/2/4-7
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F L I G H T I N F O R M A T I O N A N D M I N I M U M
C O N N E C T I N G T I M E

F O R M A T

Verify flight information for entire PNR itinerary. Get details on departure and
arrival time and date, meals, equipment, elapsed flying time, mileage, etc.

Note: Type: DU*/MLS to decode meals

Verify flight information for specific segment, range of segments or non-
consecutive flight segments.

VI*

Example:

23SEP FLT SEGMENT DPTR ARVL MEALS EQP ELPD MILES SM
1 AA*1472 SFO ORD 215P 825P S /F S80 4.10 1847 N

DEP-TERMINAL 3 ARR-TERMINAL 3
ONEWORLD
VI*(segment number)
VI*3 VI*3-5 or VI*3/5

Verify minimum connect times for itinerary VCT*

Example:

MINIMUM CONNECT TIME EDIT VALID FOR ALL CONNECTIONS
Verify minimum connect times for specific segments VCT*1/2

C A N C E L A N D R E B O O K

The Sabre system transmits the cancel to the carrier when you end your transaction. If you are canceling more than one segment and using separate
entries, cancel the highest numbered segment first.

Cancel a specific itinerary segment X(segment number)
X1

Cancel multiple itinerary segments X(segment number)/(segment number)
X1/3

Cancel a range of itinerary segments X(segment number)-(segment number)
X1-3

Cancel entire itinerary XI

Cancel all air segments XIA

Passively cancel segments, no message sent to the airline.

Note: Use this format when you need to remove a segment from your itinerary
but still hold the space with the airline.

.(segment selection)XK

.1-3XK

Cancel and rebook from a city pair availability (CPA) in one entry X(segment nbr)¥0(nbr of seats)(class of service)(CPA line nbr)
X3¥01F1

Cancel and resell same flight with same class for a different date in one entry X(segment nbr)¥00(new date)
X1¥0025APR

Change segment to new class WC(segment number)(new class)
WC1M

Selling Air Reservations Quick Reference Page | 4
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Change all segments to new class WCA(new class)
WCAY

S

Selling Air Reservations Quick Reference Page | 5
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PNR Mandatory Fields
Quick Reference

O V E R V I E W

This document explains the formats to enter, change, or delete the most common PNR mandatory fields. Use the word PRINT to remind
you of the five fields that need to be present in a PNR before ending the reservation.

P H O N E F I E L D

There should be at least two telephone fields in a PNR. Enter the agency telephone number first followed by the primary contact for the
client. Use the IATA industry Standard recommended codes in order to avoid Passenger Name Record (PNR) rejections.

Enter the phone field.

Note: Use any of the following identifiers:

9(area code)-(prefix)-(number)-identifier
9808-555-1234-A

 A= Agency

 B= Business

 F= Fax

 H= Home

Enter the phone field with an extension
9(area code)-(prefix)-(number)X(extension)-(identifier)
9080-555-2123X8971-B

Change a phone number
9(item number)¤(new phone number)-(identifier)
91¤080-963-4735-A

Delete a phone number
9(item number)¤
92¤

R E C E I V E D F R O M F I E L D

Use these formats to identify the person who authorized the changes in a Passenger Name Record (PNR).

Enter received from field.

Note: If the passenger is the reservation source, then you can use 6
and P unless your agency specify otherwise.

6(name)
6MARIA

6P

Change received from field 6¤(correct received from name)
6¤JENNY

Basic PNR Quick Reference Page | 1
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I T I N E R A R Y F I E L D

Use availability and selling formats to create itineraries. See “City Pair Availability” and “Sell Air Segments” quick references.

N A M E F I E L D

The system allows a maximum of 99 seats and passenger names, including infant name fields in one PNR. The number of names in the name field
excluding infant names must be the same as the number of booked seats.

Add single name field. -(last name)/(first name)(title – optional)

-MILLER/CAROL MS

Add multiple names in one name field for more than one person sharing
the same last name.

-(number in party with same last name)(last name)/(first name)/(first
name)
-2SAN/JOSE/MARIA

Add infant name.

Note: an infant is a child under two years who is not occupying a seat.

-I/(last name)/(first name)
-I/SAN/JUAN

Add name with reference number:

Note: Use reference numbers for accounting or identification purposes.
The Sabre system prints the reference number on both the ticket and
the Invoice/Itinerary document but does not transmit the reference
number (or MAN number, or Statement Information) to the airline.

-(last name)/(first name)*(reference number)
-SMITH/LAUREN*5467

-SMITH/LAUREN*AN5467

N A M E A S S O C I A T I O N

Each single or multiple name field added generates a different name field number. In this example: 1.0, 2.0, and 3.0. Subsequently, within the name
field each passenger is assigned its own number as follows:

1.1MILLER/CAROL MS 2.2SANCHEZ/CARLOS/MARIA 3.I/1SANCHEZ/JUAN

1.1 2.1 2.2 3.1

C H A N G E / M O D I F Y / D E L E T E N A M E

Modify a single name field -(name number)¤(last name)/(first name)
-1¤MILLER/CARLA

Modify a multiple passenger name field -(name number)¤(number in party)(last name)/(first name)/first name
-2¤2SANCHES/CARLOS/MARIA

Modify only the first name, initial, or title in a single name field -(name number)¤(first name, initial or title)
-1.1¤CARLA

Modify only the first name, initial, or title in a multiple name field -(name number)¤(first name, initial or title)
--2.2¤MARY MISS

PNR Optional Fields Quick Reference Page | 2
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Delete a name field -(name number)¤
-1¤

Delete a name from a multiple passenger name field

Note: Some carriers restrict name changes or deletions.

-(name number)¤
-2.2¤

T I C K E T I N G F I E L D / E N H A N C E D Q U E U E P L A C E M E N T

Using the 7TAW (Ticket to Print) entry, you are able to specify that a PNR be queue placed on a predefined queue on a specific future date, time.

 Indicate ticketing arrangements by adding the date you will issue tickets for a specific reservation

 Automatically place the PNR in the ticketing Queue (9) on the date specified in the entry.

With the Enhanced Queue placement process, a component of Sabre Red Efficiency Suite, you can control the date and time that PNRs appear on
queue. If you specify a date in TAW/TAX, for the current or following day, PNR will be placed on queue on the actual date/time specified in the entry.
This helps you improve your efficiency and workflow when working with queued PNRs.

Note: The system places only PNRs with active itineraries on the queue.

T A S K F O R M A T

Place PNR on Queue 9 (ticketing queue) for issuing tickets immediately
upon End Transaction.

7TAW/

Request queue placement for today at specified time. 7TAW/600P/

Note: If time entered is within 2 hours, PNR will be queue placed
immediately at End transaction

Automatically place PNR on specific Queue at specified date and time 7TAW(date)(queue number)/(time)/
7TAW23JUL55/6P/

Place PNR to specific queue at specified date and time with free text

Notes:

7TAW(date)(queue number)/(time)/free text
7TAW23JUL55/6P/PLEASE ISSUE TICKET

 When no time is included the system places the PNR on queue at
default time -0400

 Only specify top of the hours

 12/24 hour clock format (for example: 3P, 300P, 1500)

 You can combine this entry with city, branch location, queue
number, free text, etc. Refer to Format Finder for more
optionsefer to Format Finder for more options.

Place PNR on queue immediately upon End Transaction

Note: Use the TAX field (PNR Suspense Field) to place a PNR onto
Queue for miscellaneous follow up work. TAX automatically places the
PNR in the ticketing Queue (Queue number 10) on the date/time
specified in the entry

TAX/

Place PNR at specified date/time 7TAX(date)/(time)
7TAX23JUL/6P
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Place PNR at specific date/time with free text 7TAX(date)/free text
7TAW23JUL/this is a test

Add ticketing time limit for future date when you are requesting the airline
issue the tickets.

8(downline city)-(carrier code)(time)/(future date)
8SEA-DL6P/17MAY

Note: Downline city is the city listed below the originating or headline
city. For AA Omit the downline city and the carrier code.

Modify a ticketing date.

Note: The system allows only one item in the ticketing field. Another
ticketing field entry overrides any current time limit or ticketing
arrangement in the PNR.

7¤TAW(new date)/
7¤TAW14AUG/

A D D I T I O N A L R E F E R E N C E S

Find additional information in Format Finder . Type "PNR Mandatory Fields” in your Search request and select the Overview-Passenger Name
Record (PNR) option found.

PNR Optional Fields Quick Reference Page | 4
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PNR Optional Fields
Quick Reference

F R E E T E X T R E M A R K S F O R M A T

Add general information about your client. The system does not
transmit this information to the airlines

5(free text)
5PASSENGER PREFERS HILTON HOTELS

Note: An additional symbol or alpha code following the 5 identifier indicates you are entering a special type of remark as shown in the
sections below

F O R M O F P A Y M E N T R E M A R K S F O R M A T

Store CHECK form of payment in the PNR. 5-(CHECK, CK, or CHEQUE)
5-CHECK

Store CASH form of payment in the PNR.
5-CASH

Store CREDIT CARD form of payment in the PNR that generates an
approval.

Note: The * indicates request for an approval code at the time of
ticketing.

5-*(two-letter credit card code)(credit card number)¥(expiration date
month/year)
5-*AX371409203591005¥5/10

Store CREDIT CARD form of payment in the PNR that generates an
approval, but suppress the credit card information from printing on
the Invoice/itinerary when the CCMASK indicator is OFF.

Note: The CCMASK indicator in the Travel Journal Record (TJR)
defaults to ON and limit viewership of your customers’ credit card
data in PNRs and Customer Profiles (Stars). The system masks all
but the last four digits of the credit card number to all employees with

no CCVIEW Employee Profile Record (EPR) keyword.

5-*(two-letter credit card code)(credit card number)¥(expiration date
month/year)-XN
5-*AX371409203591005¥5/10-XN

I T I N E R A R Y R E M A R K S F O R M A T

Itinerary remarks print at the bottom on itineraries and combined
invoice/itineraries.

5¥(free text)

5¥REMEMBER TO TAKE YOUR PASSPORT

Add segment associated itinerary remarks. This information will
print on the itinerary right below the specified itinerary segment.

Note: Omitting the mandatory space after the segment number
causes the information not to print after the segment number.

5¥S(segment number) (text)

5¥S3 CHECK IN AT LEAST ONE HOUR BEFORE DEPARTURE
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I N V O I C E R E M A R K S F O R M A T

Add an invoice remark 5.(free text)
5.thank you for your payment

Add an invoice remark to interface client remarks to the back office
system.

Note: Omit the “S” if you want the remark to print on the invoice

5.S*(descriptor code)(remark)
5.S*IMBILL TO SMITH CORP

Add an Invoice remark to interface a customer/account ID to the back
office system.

5.S*(descriptor code)(customer/account ID)
5.S*AN3106418726

Add an Invoice remark to interface an outside agent data to the back
office system.

5.S*(descriptor code)(outside agent sign and commission)
5.S*OALC 10

Note: If you use Trams back office system, type “Trams” on the Format Finder help system search bar and access the Trams Formats help page
for a complete list of Descriptor Codes.

A L P H A C O D E D R E M A R K S F O R M A T

Add an alpha coded remark.

Note: Use letters or codes to sort remarks into specific categories such
as “tour remarks”, ”cruise remarks”, etc.

5(letter)¥(free text)
5C¥CONTACT CARNIVAL CRUISE LINE

H I S T O R I C A L R E M A R K S F O R M A T

Add an alpha coded historical remark. Historical remarks become a
permanent part of the PNR history.

5H-(free text)
5H-FARE QUOTED 690.00

Note: Document in 5H remarks hotel cancellation numbers or any
cancellation to which a vendor can assess a no-show charge

F U T U R E Q U E U E P L A C E M E N T R E M A R K S
( F Q P )

F O R M A T

You can control the date and time PNRs appear on queue. Use Future Queue Placement (5Q-) to place PNRs on queue for tomorrow and
beyond.

Notes:

 The system places only PNRs with active itineraries on the queue. Waitlisted segments or segments with a PN status do not require a
time limit.

 The PNR history includes the addition, deletion and change of all 5Q- entries

 You can specify a time using the 12 hour or 24 hour clock format (i.e. 3P, 300P, 1500).

 If you do no specify time, default times of 0600 local time (5Q-) will be used.

 Only “whole hour” times (i.e. 3pm, 12am, etc) are accepted

 If a prefatory instruction code is not included in the entry, the default will be PIC 19SPECIAL LIST

 If you do not add the pseudo city code in your entry, the system places the PNR on to your home pseudo city code queue.

 Times entered within a 2 hour processing window will be placed immediately at End Transaction
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D E S C R I P T I O N F O R M A T

Set a PNR to queue place in the future, with default time, PCC and
PIC

5Q-(pseudo city code)(a date at least two days from today or
beyond)(queue number)/(prefatory instruction code)
5Q-B4T030JUL50/81

Set PNR to queue place in the future, specifying date and time 5Q-(pseudo city code)(a date at least two days from today or
beyond)/(time of day as 12 hour, 12 hour with 00, or 24 hour time)-
(queue number)/(prefatory instruction code)
5Q-B4T030NOV/6P-50/81

Display PNR history for FQP (Default PCC, time and PIC) *H

System response:
*H
A5Q  Q-B4T015MAY/0600-100/019

Display all FQP remarks in PNR *Q-

*Q- .
REMARKS

1.Q-B4T015AUG511/019
2.Q-B4T015AUG511/100
3.Q-B4T015AUG511/099
4.Q-B4T015AUG511/200
5.Q-B4T016JUN100/019

C L I E N T D E L I V E R Y A D D R E S S F O R M A T

Enter customer address into remarks for printing on
invoice/itinerary in the left portion of the address field area. There
is a maximum of six lines of text. Each line must begin with 5/

5/(client’s name)
5/(street address)
5/(city), (state) (zip)
5/MRS CAROL ODONNELL
5/34 ROCKLAND STREET
5/WETHERSFIELD, CT 06109

Enter client delivery address field into remarks for printing on the
Invoice/Itinerary in the right portion of the address field area. There
is a maximum of six lines of text and a maximum of 39
characters per line. Each line must begin with 5DL-

5DL-(client’s name)§ 5DL-(street address)§ 5DL-(city), (state) (zip)

5DL-DAVID, HENDRICKS, AND ASSOCIATES§5DL-92
MISTY RIDGE AVENUE§5DL-MARYLAND, LAGOS

A G E N C Y A D D R E S S F O R M A T

Store agency address in the PNR. Minimum 3 lines, maximum 6
lines. Maximum 50 characters per line.

W-(agency name)¥(street address)¥(city), (state) (zip)
W-ABC TRAVEL¥123 MAIN STREET¥IKEJA, LAGOS

Note: In most cases you can find your agency address in a Star
profile. When you move the Star into a PNR, the system moves the
agency address automatically
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P A S S E N G E R E - M A I L A D D R E S S F O R M A T

Enter the passenger email field PE¥(e-mail address)¥
PE¥SUSAN.JONES@EMAIL.COM¥

Override the email From field stored in the agency’s Travel Journey
Record (TJR). Permits the passenger to send a reply directly to the
agent’s inbox.

Note: Use two equal (=) signs for an underscore symbol (_)

PE¥(e-mail address)¥FR/(sender’s name)
PE¥STEVEN@VINCENTTRAVEL.COM¥FR/STEVEN
VINCENT, CTC

D K N U M B E R F O R M A T

Add DK number.

Note: Use a six, seven or ten-digit customer number as an account
reference identifier for billing/back office purposes.

DK(customer number)
DKIBM300

DK1234567

Send a customer identification number to Trams

Notes:

 Use this format to transmit customer/account numbers
regardless of formatting to your Trams back office system.

 A “AN” number overrides an existing DK number

5.S*AN(customer number)
5.S*AN21121105

F R E Q U E N T F L Y E R N U M B E R S F O R M A T

Transmit frequent traveler number (name select is not required for
PNRs with one passenger only)

FF(airline code)(number)-(name field number)
FFSR1234567-1.1

Transmit frequent traveler number of one airline to accrue miles on
another airline (Example: BA flight miles will be credited to AA
frequent traveler number)

FF(airline code)(number)/(airline code)-(name field number)

FFAA1234567/BA-1.1

O S I ( O T H E R S E R V I C E I N F O R M A T I O N ) F O R M A T

Use OSI messages when you do not require action or a reply by the carrier. They are low-priority messages and are usually used for
information purpose only.

Note: Use the GFAX field (3) to send messages to all carriers, except American Airlines. Use the AFAX field (4) to send and receive messages
to and from American Airlines, and to receive inbound messages from all carriers.

Transmit FYI information to all carriers except American Airlines. 3OSI (airline code) (free text)
3OSI UA TCP2/ BROEDER THORSTEN

Transmit FYI information to American Airlines 4OSI (free text)
4OSI TRAVELING WITH INFANT PAUL RITA 18 MTHS

Transmit FYI information for a specific passenger name to carrier. 3OSI (airline code) (free text)-(name field number)
3OSI BA SPEAKS FRENCH ONLY-1.2
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S S R ( S P E C I A L S E R V I C E R E Q U E S T ) F O R M A T

Use SSR messages when you require an action or a reply to your request. Add a special service code to identify the service item you request.
In the search request of Format Finder type “Send an SSR” to find special service codes.

Transmit special meal request to carrier on specified segment using
name select

Notes:

 Type DU*/SPM to display special meals table.

 Some meal code descriptions have changed, and some new
meal codes exist according to IATA mandates. Check Format
Finder for meal codes and meal code descriptions.

Transmit wheelchair request to American Airlines for specific segment
using name select

3(special service code)(segment)-(name field number)

3VGML2-1.2

4(special service code)(segment)-(name field number)

4WCHR3-2.1

Use SSR messages to transmit mandatory information to the airline, such as infant details, Form of Identification (FOID), Advance Passenger
Information (APIS) or Secure Flight Passenger Data.

Note that you use the GFAX field (3) to send messages to all carriers , and the AFAX field (4) to send messages to American Airlines

Send infant’s age for an infant on all segments traveling with one
adult

3INFT/(infant’s last name)/(infant’s first name)/(date of birth)
3INFT/SMITH/KELLY/06MAR09

Note: Check Format Finder to send other INFT details.

Send infant’s age for an infant on all segments traveling with one
adult for American Airlines

4INFT/(infant’s last name)/(infant’s first name)/(date of birth)
4INFT/SMITH/KELLY/06MAR09

Enter passport as FOID

Note: Check Format Finder to send other FOID information.

3FOID/PP(country code and passport number)
3FOID/NG123456789

Enter passport as FOID for American Airlines 4FOID/PP(country code and passport number)
4FOID/NG123456789

Enter passport information as APIS

Notes: To indicate "all" segments, replace the segment number with
A or omit the segment number.

This example shows the use of all possible fields, including the use of
the H to indicate the primary passport holder in a multiple passenger
passport

3DOCS(segment number)/(document type)/(document issue
country)/(document number)/(document nationality country)/(date of
birth)/(gender)/(document expiration date)/(last name)/(first
name)/(middle name or initial)/H-(PNR name number)
3DOCS2/P/NG/1234567890/NG/15AUG1947/M/30SEP2020/
ADAMS/OLU/OBI/H-2.1

Enter passport information as APIS for Infant Passenger 3DOCS(segment number)/(document type)/(document issue
country)/(document number)/(document nationality country)/(date of
birth)/(gender Infant)/(document expiration date)/(last name)/(first
name)/(middle name or initial)/H-(PNR name number of associated
Infant)
3DOCSA/P/NG/1234567890/NG/15AUG2013/MI/30SEP2020
/ADAMS/OLU/OBI/H-2.1
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Enter Visa information as APIS

Notes:

This example shows inclusion of all fields (name select and segment
select), except the lap child indicator. Also note that the "place of
birth" field includes a space. The /CH is the visa applicable country

3DOCO(segment number)/(place of birth)/(document type)/(document
number)/(place of issue)/(visa issue date)/(visa applicable
country)/(lap child indicator)-(PNR name number)
3DOCO2/LYON FR/V/789789/PARIS FR/14JUN2005/CH-2.1

Check Format Finder to send other APIS information

Enter Visa information as APIS for American Airlines 4DOCO(segment number)/(place of birth)/(document type)/(document
number)/(place of issue)/(visa issue date)/(visa applicable
country)/(lap child indicator)-(PNR name number)
4DOCO2/LYON FR/V/789789/PARIS FR/14JUN2005/CH-2.1

Enter destination address information

Note:

This destination address example shows inclusion of all fields (name
select and segment select), except the lap child indicator.

3DOCA(segment number)/(address
type)/(country)/(street)/(city)/(state or province)/(zip or postal
code)/(lap child indicator)/-(PNR name association)
3DOCA2/D/GB/10 DOWNING STREET/LONDON/EN/7A1
H3P-2.1

Enter destination address information for American Airlines

Note:

This destination address example shows inclusion of all fields (name
select and segment select), except the lap child indicator

4DOCA(segment number)/(address
type)/(country)/(street)/(city)/(state or province)/(zip or postal
code)/(lap child indicator)/-(PNR name association)
4DOCA2/D/GB/10 DOWNING STREET/LONDON/EN/7A1
H3P-2.1

Enter no in-flight meal SSR

Note:

3NOML(segment number)-(name association)
3NOML1-1.2

Free text is not allowed with this SSR.

Airlines are not required to send a reply message.

N E W O P T I O N A L S S R C O D E S D U R I N G I R O P – C O N T A C T I N F O R M A T I O N

O V E R V I E W

With the new optional SSR Codes (SSR CTCE, CTCM and CTCR) you can provide customer contact information to be used by airlines during
an irregular operation (IROP), as per IATA recommended practice.

 There is no limitation on number of CTCE, CTCM or CTCR SSR´s associated to a passenger in the PNR.

 Even though this is an optional SSR, in the event the passenger refuses to provide this information, CTCR SSR could be applied to the
booking, indicating that the passenger has refused to provide IROP contact information

Notes regarding CTCE and CTCM:

 Both SSRs are optional fields.

 Both SSR CTCE format and email address format are validated at input.

 Optional Language code is allowed in CTCM and CTCE SSRs.

 2 alpha characters for language code will be validated.

 // is used in place of the @ sign in email address.

 .. is used in place of the _ (underscore) in the email address.

 ./ is used in place of the – (hyphen) in the email address.
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D E S C R I P T I O N F O R M A T

Enter Passenger IROP contact information mobile phone with
passenger association.

Notes:

 YY indicates no segment association

 Applies to all carriers in the itinerary

Enter Passenger IROP contact information mobile phone with
passenger association and segment association

Enter Passenger IROP contact information mobile phone with
language code and passenger association

3CTCM/(Phone number)-(Name association)
3CTCM/1223344444-1.1

System response:

3CTCM/1223344444-1.1*
*P3«
GENERAL FACTS
1.SSR CTCM YY 1223344444 1.1 SMITH/J
4CTCM(segment number)/(Phone)-(Name association)
4CTCM1/1223344444-1.1

System response:

4CTCM1/1223344444-1.1*
*P4«
HOST FACTS

1.SSR CTCM LA HK1/1223344444-1.1 SMITH/J
3CTCM/(Phone number)/(Language code)-(Name association)
3CTCM/1223344444/DE-1.2

System response:

Enter Passenger IROP contact information email address with
passenger association

Note: //= @

3CTCM/134455555/DE-1.2*
*P3«
GENERAL FACTS
1.SSR CTCM YY 1223344444/DE 1.1 SMITH/J
3CTCE/(Email address)-(Name association)
3CTCE/JOHN.SMITH//AOL.COM-1.1

System response:

3CTCE/JOHN.SMITH//AOL.COM-1.1*
*P3«
GENERAL FACTS
1. SSR CTCE YY NN1/JOHN.SMITH//AO 1.1
TEST/TEST

L.COM

Enter Passenger IROP contact information email address with
language code and passenger association

Note: //= @

3CTCE/(Email address)/(language code)-(Name association)
3CTCE/JOHN.SMITH//AOL.COM/EN-1.1

System response:
3CTCE/JOHN.SMITH//AOL.COM/EN-1.1*
*P3«
GENERAL FACTS
1. SSR CTCE YY NN1/JOHN.SMITH//AO 1.1
TEST/TEST

L.COM/EN
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D E S C R I P T I O N F O R M A T

Enter Passenger IROP contact information refused with passenger
association and free text

Note: Free text information is optional

Enter Passenger IROP contact information with passenger
association and without free text

3CTCR/(Free text)-1.1
3CTCR/(Refused)-1.1

System response:
3CTCR/REFUSED-1.1
P3*
GENERAL FACTS
1.SSR CTCR/REFUSED 1.1 SMITH/A
3CTCR(segment number)-(Name Association)
3CTCR1-1.1

System response:
3CTCR1-1.1
P3*
GENERAL FACTS
1.SSR CTCR LA HK1 1.1 SMITH/A

M O D I F Y I N G O P T I O N A L F I E L D S D E L E T I N G O P T I O N A L F I E L D S

Modify Remarks

Note: The basic change format starts
with 5(line number). Then after the ¤
character, you add the code for that
type of remark (except for free text
remarks) followed by the new text

5(line number)¤(new text)
53¤BRING YOUR ID

5(line number)¤(alpha/symbol
code)(new text)
51¤-CASH

53¤¥EARLY CHECK IN

52¤/65073 DIEBURG

Delete Remarks 5(line number)¤
51¤

Change Agency Address W-(line number)¤(new address
information)
W-3¤DALLAS TX 75201

Delete Agency Address W-¤

Passenger e-mail Address PE(line number)¤¥(new e-mail)
PE2¤¥JOHN
SIMITH@IBM.COM¥

Delete Passenger e-mail Address PE(line number)¤
PE2¤

DK number

Note: A new DK number overlay the
original number.

DK(new number)
DK123456

You cannot delete a DK number.

Frequent Flyer Number FF(line number)¤(carrier
code)(frequent flyer nbr)
FF1¤UA5522123

Delete Frequent Flyer Number

Delete all Frequent Flyer Numbers

FF(line number)¤
FF1¤

FF¤ALL
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OSI information

Note: Use 4 (AFAX) for AA

3(line nbr)¤OSI(new text)
32¤OSI UA PREFERS AISLE

42¤OSI SPEAKS FRENCH

Delete OSI information 3(line nbr)¤ or 4(line nbr)
¤
32¤ or 42¤

SSR information 3(line nbr)¤(SSR code)-(name
nbr) ¤
32¤VGML-2.1

42¤BBML-3.1

Delete SSR information 3(line nbr)¤ or 4(line nbr)
¤
32¤ or 42¤

A D DT I O N A L R E
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PNR Passenger Association
Quick Reference

O V E R V I E W

Passenger Association increases your agent productivity and streamlines your agency workflow by reducing booking process duration.

 Improve your agency workflow by adding association capability to the phone and remark fields with a single, a series or a range of passenger
names, which allows you to effectively identify passenger specific information

 Streamline back office processing by providing enhanced back office transmission to accommodate passenger association detail in the
itinerary, invoice, and interface remarks

 Increase efficiency by enhancing PNR Divide process, so that all passenger’ associated information moves from the original PNR to the
divided PNR following the appropriate passenger. Also, when reducing number in party, the passenger associated data will be removed,
reducing manual processing.

 Provide history detail of phone and remarks association data

T J

O C I A T I O N

A D D P A S S E N G E R A S S O C I A T I O N T O
P H O N E F I E L D

F O R M A T

Add a new phone field and associate it to a passenger number

Note: the phone field can contain numeric, alpha or a combination of
alpha numeric characters.

AS¥(name number)¥9¥(phone number)-(phone type)
AS¥N3.1¥9¥080-457-0747-H

Add a new phone number and associate a series of name numbers
at the same time into a PNR

AS¥(name number, name number, name number)¥9¥(phone number)-
(phone type)
AS¥N1.1,3.1,7.1¥9¥080-457-0747-H

Add a new phone number and associate a range of name numbers
at the same time into a PNR

AS¥(name number-name number)¥9¥(phone number)-(phone type)
AS¥N1.1-4.1¥9¥080-457-0747-H

Add passenger name association to an existing phone field in the
PNR

AS¥(name number)¥9(line number)
AS¥N1.1¥92

Add a series of names to an existing phone field in the PNR AS¥(name number, name number, name number) ¥9(line number)
AS¥N1.1,4.1,8.1,9.0¥92

Add a range of names to an existing phone field in the PNR AS¥(name number, name number, name number)¥9(line number)
AS¥N1.1,3.1,7.1¥91
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A D D P A S S E N G E R A S S O C I A T I O N T O A R E M A R K F I E L D

Remarks that can be name associated

Note: Please refer to Format Finder for the complete list of remarks
that can be name associated.

 Historical remark (5H-)

 Hidden remark (5HR-)

 Corporate number remark (5C-CORP number)

 Itinerary Form Remark (5¥)

 Invoice Form Remark (5.)

 Interface Remark (5.)

 Address Remark (5/)

 Delivery Address Remark (5DL-)

 Alpha Remark

D E S C R I P T I O N F O R M A T

Add a free text remark to the PNR and name associate it to a
passenger in a single entry

AS¥(name number)¥5¥(free text)
AS¥N1.1¥5¥THIS IS A TEST

Add a new free text remark to the PNR and name associate it to a
series of names

AS¥(name number,name number,name number)¥5¥(free text remark)
AS¥N1.1,2.2,6.1¥5¥THIS IS A TEST

Add a new free text remark to the PNR and name associate it to a
range of names

AS¥(name number- name number)¥5¥(free text remark)
AS¥N1.0-7.0¥5¥THIS IS A TEST

Add a name association to an existing free text remark field AS¥(name number-name number)¥5(remark line number)
AS¥N1.0-7.0¥54

Add a series of name associations to an existing free text remark
field

AS¥(name number,name number,name number)¥5(remark line number)
AS¥N1.1,2.2,6.1¥54

Add a range of name associations to an existing remark field AS¥(name number-name number)¥5(remark line number)
AS¥N1.0-7.0¥54

Add a name association to a historical remark field in a single entry
when creating a new PNR or adding to an existing PNR

AS¥(name number¥5¥H-(free text)
AS¥N1.2¥5¥H-TEST

Add a passenger association to an Itinerary Remark and name
associate it in the PNR in a single entry

AS¥ (name number) ¥5¥¥(free text)
AS¥N1.2 ¥5¥¥THANK YOU FOR YOUR BUSINESS

Note: the format includes two Crosses of Lorraine ¥¥

Add a passenger association to a new Invoice Remark AS¥(name number)¥5¥.(free text)
AS¥N1.2¥5¥.THIS IS A TEST

M O D I F Y P A S S E N G E R A S S O C I A T O N O F P N R F I E L D S

You can add additional name associations to a PNR data field and modify the existing data field at the same time. When modifying the existing data
field, all current name associations are retained

Modify existing phone number by adding an additional name
association and modifying the phone number at the same time

AS¥(name number)¤9(line number)¤(phone number)-(phone type)
AS¥N1.1¤92¤817-333-4444-H

Modify a Free Text Remark and name association at the same time AS¥(name number)¤55¤(free text)
AS¥N1.1¤55¤REQUEST NEW ROOM ASSIGNMENT
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R E M O V E P A S S E N G E R N A M E A S S O C I A T I O N I N A N E X I S T I N G R E M A R K F I E L D

You can add additional name associations to a PNR data and modify the existing data field contained on the Remark or Phone at the same time.
When modifying the existing data field only, all current name associations are retained.

Remove a name association and change an existing remark in a
single entry

AS¤(name number)¤9(line number)¤(phone number)-(phone type)
AS¤N1.1¤92¤817-333-4444-H

Remove a name association and retain the remark AS¤(name number)¤9(line number)
AS¤N1.1¤92

R E M O V E P A S S E N G E R N A M E A S S O C I A T I O N I N A N E X I S T I N G P H O N E F I E L D

Remove a name association and change an existing phone number in
a single entry

AS¤(name number)¤5(line number)¤(free text remark)
AS¤N2.1¤52¤THIS IS A FREE TEXT REMARK

Remove a name association and retain the phone and any other
name associations in a PNR phone field

AS¤(name number)¤5(line number)
AS¤N2.1¤52

D E L E T E P N R F I E L D S

Delete a PNR data field and all names associated to that field in a
single entry.

9(line number)¤
92¤

Delete the Remark Field and all Name Associations 5(line number)¤
53¤

D I S P L A Y P A S S E N G E R A S S O C I A T I O N O F P N R F I E L D S

Improve your agency efficiency by having the ability to easily identify non-passenger associated information as well as passenger associated phone,
remarks, frequent flyer, SSRs, OSIs, tickets, accounting lines, etc.

Important note: if you work at an agency home office with several branch offices, and such home office has the TJR setting ON but the branch
offices do not, then the agents at the branch offices will see the PNR exactly as they see it today.
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Display all Passenger Associated Data AS*

1.1DUBOIS/MARC 2.1DUBOIS/JESSICA
1 BA 113Y 25JAN 5 LHRJFK HK2 1130 1430 /DCBA*5UXHHO /E
2 BA 178Y 02FEB 6 JFKLHR HK2 0830 2015 /DCBA*5UXHHO /E

TKT/TIME LIMIT
1.TAW/

PHONES
1.LOS080-605-7678-A
2*LOS080-555-5555-H
1.1DUBOIS/MARC

3*LOS080-333-4444-B
2.1DUBOIS/JESSICA

REMARKS
1*H-CAR NEEDED IN NEW YORK
1.1DUBOIS/MARC
2.1DUBOIS/JESSICA

2..CHANGES ARE SUBJECT TO PENALTY USD100
3..CORPORATE RATE APPLIED

ACCOUNTING DATA
1. BA‡4135519428/ .00/ 1177.00/356.05/ONE/CCAXXXXXXX

XXXXX8001 1.1DUBOIS/MARC/1/F/E
1.1DUBOIS/MARC

2. BA‡4135519429/ .00/ 1177.00/356.05/ONE/CCVIXXXXXX
XXXXX2530 2.1DUBOIS/JESSICA/1/F/E

2.1DUBOIS/JESSICA

Display all Passenger Associated Data for a specific Passenger

Note: The display shows all non-associated and applicable name
associated PNR fields including: phone, remarks, frequent flyer,
SSRs, OSIs, tickets, accounting lines, etc.

*T
TKT/TIME LIMIT

1.T-16MAR-A1B2*HAF
2.TE 1254135519428-AT DUBOIS/M A1B2*HAF 1428/16MAR*I

1.1DUBOIS/MARC
3.TE 1254135519429-AT DUBOIS/J A1B2*HAF 1428/16MAR*I

2.1DUBOIS/JESSICA
AS*N2.1

2.1DUBOIS/JESSICA
1 BA 113Y 25JAN 5 LHRJFK HK2 1130 1430 /DCBA*5UXHHO /E
2 BA 178Y 02FEB 6 JFKLHR HK2 0830 2015 /DCBA*5UXHHO /E

TKT/TIME LIMIT
1.TAW/

PHONES
1.DFW682-605-7678-A
3*DFW817-333-4444-B

GENERAL FACTS
2.OSI BA GERMAN SPEAKER 2.1 DUBOIS/JESSICA

REMARKS
1*H-CAR NEEDED IN NEW YORK
2..CHANGES ARE SUBJECT TO PENALTY USD100
3..CORPORATE RATE APPLIED

ACCOUNTING DATA
2. BA‡4135519429/ .00/ 1177.00/356.05/ONE/CCVIXXXXXX

XXXXX2530 2.1DUBOIS/JESSICA/1/F/E
2.1DUBOIS/JESSICA

*T
TKT/TIME LIMIT

1.T-16MAR-A1B2*HAF
3.TE 1254135519429-AT DUBOIS/J A1B2*HAF 1428/16MAR*I

2.1DUBOIS/JESSICA
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D E S C R I P T I O N E X A M P L E

Display phone field

Note: the display shows the asterisk (*) after the line number to
indicate there is a name associated to this phone field

*P9

Sabre system response:

1.888-123-4567-A
2*817-217-3456-B
3*469-345-9870-C
4.972-405-6523-B

Display all the details of all the name associated phone numbers AS*P9

Sabre system response:

1.888-123-4567-A
2*817-217-3456-B
1.1 SMITH/MARY
2.1 STEWART/JOHN

3*469-345-9870-C
3.1 ANDERSON/ANGELA
4.972-405-6523-B

Display all the phone numbers for a specific passenger name
number

AS*(name number)*(phone field)
AS*N1.1*P9

1.888-123-4567-A
2*817-217-3456-B
4.972-405-6523-B

Display all the details for a series of name associated phone
numbers

AS*P9*2,3

Sabre system response:

2*817-217-3456-B
1.1 SMITH/MARY
2.1 STEWART/JOHN

3*469-345-9870-C
3.1ANDERSON/ANGELA

D I S P L A Y N A M E A S S O C I A T I O N D E T A I L
F O R R E M A R K F I E L D S

E X A M P L E

Display remarks

Note: the display shows the asterisk after the line number to indicate
there is a name associated to this remark field

*P5

Sabre system response:

1*FREE TEXT REMARK
2.H-HISTORICAL REMARK
3*HR-HIDDENREMARK
4.C-CORP874524850258209
5*‡ITINERARY REMARK
6*.INVOICE REMARK
7*/ADDRESS REMARK
8*DL-DELIVERY REMARK
9.X/-INTERFACE REMARK
10.A-ALPHA REMARK FOR A TO Z

Display a specific remark line *P5*H5

2.H-HISTORICAL REMARK
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Display all name association details for the remarks field AS*P5

1*FREE TEXT REMARK
1.1SMITH/MARY

2.H-HISTORICAL REMARK
3*HR-HIDDENREMARK

1.1SMITH/MARY
4.C-CORP874524850258209
5*‡ITINERARY REMARK

2.1STEWART/JOHN
3.1ANDERSON/ANGELA

6*.INVOICE REMARK
3.1ANDERSON/ANGELA

7*/ADDRESS REMARK
1.1SMITH/MARY
3.1ANDERSON/ANGELA

8*DL-DELIVERY REMARK
2.1 STEWART/JOHN

9.X/-INTERFACE REMARK
10.A-ALPHA REMARK FOR A TO Z

Display all remarks for a specific passenger name number

Note: all remarks display in the numerical order as they are on the
face of the PNR

AS*(name number)*(remarks field)
AS*N1.1*P5

AS*N1.1*P5
1*THIS IS A FREE TEXT REMARK
3*.THIS IS AN INVOICE REMARK
4*‡THIS IS AN ITINERARY REMARK
5.H-THIS IS A HISTORICAL REMARK
8.T‡ELEPHANT JUNGLE TOUR

Display all the details for a series of name associated remarks AS*P5*2,3

2.H-HISTORICAL REMARK
3*HR-HIDDENREMARK

1.1SMITH/MARY

D I S P L A Y N A M E A S S O C I A T I O N D E T A I L
F O R A C C O U N T I N G L I N E S

E X A M P L E

Display accounting lines *PAC

Sabre system response:

ACCOUNTING DATA
1. BA‡4135519428/ .00/ 1177.00/356.05/ONE/CCAXXXXXXXXXX

XX8001 1.1DUBOIS/MARC/1/F/E
2. BA‡4135519429/ .00/ 1177.00/356.05/ONE/CCVIXXXXXXXXX

XX2530 2.1DUBOIS/JESSICA/1/F/E

Display details of all name associated data in the Accounting Lines
AS*PAC

Sabre system response:

ACCOUNTING DATA
1. BA‡4135519428/ .00/ 1177.00/356.05/ONE/CCAXXXXXXXXXX

XX8001 1.1DUBOIS/MARC/1/F/E
1.1DUBOIS/MARC

2. BA‡4135519429/ .00/ 1177.00/356.05/ONE/CCVIXXXXXXXXX
XX2530 2.1DUBOIS/JESSICA/1/F/E

2.1DUBOIS/JESSICA

Display all accounting lines for a specific passenger
AS*N1.1*PAC

ACCOUNTING DATA
1. BA‡4135519428/ .00/ 1177.00/356.05/ONE/CCAXXXXXXXXXX

XX8001 1.1DUBOIS/MARC/1/F/E
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Secure Flight
Quick Reference

O V E R V I E W

The Secure Flight Program, developed by the Department of Homeland Security (DHS), enhances the security of U.S. domestic and international
commercial air travel by using improved watch list matching. This program mandates all aircraft operators to collect and transmit Secure Flight
Passenger Data (SFPD) for all passengers traveling; to, from, within, and over the United States regardless of operating carrier, as well as point-to-
point international flights operated by U.S.-based airlines.

You store Secure Flight mandatory data elements in the IATA SSR standard DOCS. Mandatory data elements include:

 Passengers Full Name, (as shown on state or government issued identification documents such as a State ID Card, Driver’s License or
Passport). Must use same ID upon airport check in.

 Date of Birth

 Gender

 Optional Secure Flight data elements include:

 Redress Number - Unique number assigned by the DHS to individuals who elect to use the DHS Travel Redress Inquire Program (TRIP). A
traveler who has a Redress number is someone who has a similar or same name to somebody on the Government watch list. If the traveler
does not provide the Redress number, the airline check-in agent could detain them for further verification and clearance.

 Known Traveler Number - Unique number for pre-screening program to expedite security processes for certain frequent flier members and
certain members of government approved trusted traveler programs such as Global Entry, NEXUS, SENTRI

The TSA compares the SFPD against the government watch list, and provides airline approval to issue the boarding pass.

B E N E F I T S

The TSA completes the comparison of SFPD against the government watch list, allowing to

 Prevent individuals on the No Fly List from boarding an aircraft

 Identify individual on the Selectee List for enhanced screening

 Prevent individuals on the No Fly List from boarding an aircraft

 Identify individual on the Selectee List for enhanced screening

 Identify known and suspected terrorists

 Facilitate passenger air travel

 Protect individual’s privacy

 Identify known and suspected terrorists

 Facilitate passenger air travel

 Protect individual’s privacy

I M P O R T A N T I N F O R M A T I O N

 The SFPD must be present in the Passenger Name Record (PNR) 72 hours prior to departure and must exactly match the document
presented at airport check-in. Airlines cannot print boarding passes for passengers until the TSA completes the comparison of SFPD against
the Government watch list.

 Secure Flight does not replace APIS. The collection of APIS to store Passport and Visa information is still required and the format data does
not change. If you have stored APIS data using the SSR DOCS, there is no need to store an additional SSR DOCS with the SFPD.

 You can store the Secure Flight data in a Profile.

If the passenger refuses to disclose the information while making the reservation, you can still make the booking, but you should warn the passenger
that the reservation is at risk.

 Delays may take place at time of check-in, with the risk of missing the flight

 Air carrier may issue a debit memo to your agency

 Air carrier may cancel the reservation

 Air carrier may programmatically inhibit ticketing, regardless of the ticketing system (see next page for more detail)
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Air carrier may cancel the reservation (SSR ADPI):

Some airlines will advise your agency in advance prior to cancellation, most likely using a Special Service Request (SSR), such as OTHS or ADPI
(Advise Passenger Information). This SSR is optional, and use is at the discretion of the airline.

Examples: SSR OTHS KK1 PNR SUBJECT TO CANCEL DUE TO INVALID SFPD DATA

Notes:

 The text displaying after the airline and flight number is freeform and may differ from carrier to carrier.

 The airline transmits this SSR to your agency and places the PNR on your Queue 42 using prefatory instruction code (PIC) 165 - Passenger
Security Data Required

 You must provide the passenger(s) SFPD using the IATA standard SSR DOCS input

 At end transaction, the system transmits the teletype SSR DOCS back to the airline

Air carrier may programmatically inhibit ticketing, regardless of the ticketing system

If ticket issuance fails due to SFPD missing from the PNR, you receive an error message from the airline:

UNABLE TO PROCESS ETR-CORRECT/RETRY OR ISSUE PAPER TICKET -800

PASSENGER SECURITY IDENTIFICATION MISSING/INCOMPLETE

To issue the ticket you can either:

 Add SFPD using the SSR DOCS for those passengers and segments missing the data, end transaction (to send the SSR message to the
carrier) and then re-enter the ticket command

 Re-enter the ticket command for only the passenger(s) and/or segment(s) for which SFPD exists

 Contact the airline directly and provide the SFPD, after which re-enter the ticketing entry

G D S I N H I B I T T I C K E T I N G

Sabre system participating air carriers are also able to participate in a Secure Flight Inhibit Ticketing service. Airline participation is optional.

At the time of ticketing, Sabre system ticketing validates that SFPD is present in the PNR for each carrier in the itinerary that activates this service. If
SFPD is not present for the passenger(s)/segment(s) being ticketed, the system returns an error response:

PASSENGER SECURITY DATA REQUIRED PLEASE UPDATE AND RETRY

To issue the ticket you can either:

 Add SFPD using the SSR DOCS for those passengers and segments missing the data, end transaction and then re-enter the ticket command

 Re-enter the ticket command for only the passenger(s) and/or segment(s) for which SFPD exists.

Note: The Sabre system cannot guarantee the validation checks ensure the issuance of a ticket. The validating carrier is the final arbiter in all
instances. If the validating carrier deems that SFPD is not present and/or correct, then they will reject ticket issuance
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S E C U R E F L I T H P N R O P T I O N A L E D I T S

The Sabre system offers new Secure Flight PNR Optional Edits to power your business performance by enabling you to be proactive in identifying
PNRs missing SFPD up front in the booking process.

Mandatory Secure Flight Edit:

 You must activate the Mandatory Secure Flight Edit in your agency TJR.

 At PNR end transaction, the system performs validation against the air itinerary to ensure SFPD exists for each passenger in the PNR for
those air segments that require SFPD.

 If SFPD is missing for one or more passengers at time of PNR end transaction, the system returns a warning message to advise you that
SFPD information is required and missing from the PNR.

 PSGR SECURITY DATA REQUIRED PLEASE UPDATE AND RETRY N1.1 –S1

 If you have added the SFPD data, the validation is successful and you can end transaction the PNR

Queue Place Secure Flight Edit:

 The system places the PNR on queue 44 at time of end transaction if SFPD is missing from the PNR for one or more passengers in the PNR.

 You must activate the Queue Place Secure Flight Edit in your agency TJR.

 At PNR end transaction, the system validates against the air itinerary to ensure SFPD exists for each passenger in the PNR for those air
segments that require SFPD.

 If SFPD is missing for one or more passengers at time of PNR end transaction, the system places the PNR on queue 44 for further action.

Note: The system does not return any warning message

Combine Optional and Queue Place Secure Flight Edit:

 You must activate both the Optional Edit and Queue Place Secure Flight Passenger Data Edit in your agency TJR.

 At PNR end transaction, the system performs validation against the air itinerary to ensure SFPD exists for each passenger in the PNR, for
those air segments that require SFPD.

 If SFPD is missing for one or more passengers at time of PNR end transaction, you receive a warning message to advise you that SFPD
information is required and missing from the PNR.

 You can override this message with another end transaction command, allowing the system to end transaction of the PNR, and placing the
PNR on queue 44 for further action.

PSGR SECURITY DATA REQUIRED PLEASE UPDATE AND RETRY N1.1 –S1

ER

RECORD LOCATOR REQUESTED

R I E S
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E N T E R S E C U R E F L I G H T D A T A

There are two International Air Transport Association (IATA) approved industry standard message formats:

 Use SSR (Special Service Request) DOCS to add mandatory information: Passenger’s Full Name, Date of Birth, and Gender.

 Use SSR DOCO to add optional fields such as Redress Number or Known Traveler Number.

I M P O R T A N T I N F O R M A T I O N

 If the itinerary consists of American Airlines and any other airline(s), you must enter separate SSRs, one for American Airlines and another for
the other airline(s).

 To send Secure Flight passenger data to all carriers use 3DOCS and 3DOCO. To send Secure Flight passenger data to American Airlines
only, use 4DOCS and 4DOCO.

 If there are codeshare flights in the itinerary, send the information to the marketing carrier only, not to the operating carrier

 You must re-enter the SSR in the PNR so that it can be transmitted to the carrier when:

 You add a new segment to the current itinerary

 You cancel and rebook a segment on a different carrier

 Middle/second name is optional.

 However, if the official document the passenger presents upon check-in at the airport contains the middle/second name, you must also
include that name in the SFPD data so it exactly matches the document.

 Titles (Mr., Mrs., Dr., etc.) should not be included in the SSR DOCS entry, even though you add titles in the name field of the PNR.
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Enter mandatory Secure Flight fields

Use these codes to indicate gender:

For hyphenated last names, insert spaces to replace the hyphen.

Note: The Sabre system assumes the entry is for all segments if you do
not enter specific segment numbers or A for all segments in the format.

3DOCS(segment number or A for all)/DB/(date, month, year of
birth)/(gender code)/(last name)/(first name)-(PNR name number)
3DOCS1/DB/13JUL71/M/SMITH/JOHN-1.1

with optional middle/second name

3DOCS(segment number or A for all)/DB/(date, month, year of
birth)/(gender code)/(last name)/(first name)/(middle/second name)-(PNR
name number)
3DOCS1/DB/13JUL71/M/SMITH/JOHN/PAUL-1.1

For American Airlines:

4DOCS(segment number or A for all)/DB/(date, month, year of
birth)/(gender code)/(last name)/(first name)-(PNR name number)
4DOCS1/DB/13JUL71/M/SMITH/JOHN-1.1

with optional middle/second name

4DOCS(segment number or A for all)/DB/(date, month, year of
birth)/(gender code)/(last name)/(first name)/(middle/second name)-(PNR
name number)

4DOCS1/DB/13JUL71/M/SMITH/JOHN/PAUL-1.1

Enter Redress Number with optional country of issue

Note: Remember to begin this format with 4 for American Airlines.

3DOCO (segment number or A for all)//R/(redress number)///(country of
issue)-(PNR name number).
3DOCO1//R/123456789///US-2.1

I N F A N T F O R M A T S

Enter mandatory fields for an infant not occupying a seat

Note: Use infant gender code (MI – male infant, FI – female infant). It is
mandatory to associate the infant’s secure flight data to the name
number of the adult traveling with them.

3DOCS(segment number or A for all)/DB/(date, month, year of
birth)/(gender code)/(last name)/(first name)/(second/middle name)-(PNR
adult name number)
3DOCS1/DB/20JAN09/MI/SMITH/EDWARD/RON-1.2

Enter mandatory fields for an infant occupying a seat

Note: Use adult gender code (M – male, F – female). Associate to the
infant’s name number.

3DOCS(segment number or A for all)/DB/(date, month, year of
birth)/(gender code)/(last name)/(first name)/(second/middle name)-(PNR
infant name number)
3DOCS1/DB/20JAN09/M/SMITH/JOSEPH/EDWARD-2.1

Enter specific Redress Number for an infant with optional country of
issue

3DOCO(segment number or A for all)//R/(redress number)///(country of
issue)/I(infant)-(PNR name number)
3DOCOA//R/123456789///US/I-2.1

Note: Remember to begin these formats with 4 for American Airlines

S E C U R E F L I G H T – K N O W N T R A V E L L E R N U M B E R / T S A P R E C H E C K

Known Traveler Number, also known as TSA PRE CHECK, is a unique identification number that may expedite the screening process for selected
travelers through security checkpoints at certain airports in the United States.

Passengers should advise you of their number so you can store this number in the PNR, along with the other mandatory Secure Flight data elements.

Like the Redress Number, the Known Traveler number is an optional Secure Flight field and can be stored in a Sabre system PNR or Profile using
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the IATA standard format; SSR DOCO/K.

Enter Known Traveler number for adult or child 3DOCO(assume all segments)//K/(Known Traveler number)-(PNR name
number)
3DOCO//K/123456789-2.1

or

3DOCO(segment number o A for all)//K/(Known Traveler number)-(PNR
name number)
3DOCO1//K/123456789-2.1

Enter Known Traveler number assumes all segment with optional
country of issue

3DOCO(assumes all segments)//K/(Known Traveler number)///(country
code)-(PNR name number)
3DOCO//K/123456789///US-2.1

Known Traveler number for infant associated to an adult, with specific
segments and country of issue

3DOCO(select segments)//K/(Known Traveler number///(country code)/I-
(PNR name number)
3DOCO1//K/123456789///US/I-2.1

Note: Remember to begin these formats with 4 for American Airlines.

P N R D I S P L A Y S

When SFPD exists in the PNR, you see this banner:

SECURITY INFO EXISTS *P3D OR *P4D TO DISPLAY.

Use the formats below to display the SFPD.

Display help on all possible manual accounting lines in a PNR. All Airlines except
American Airlines

American Airlines
Only

*P3D *P4D

Display all SSR DOCA, DOCO and DOCS information stored in PNR
history

*H3D *H4D

Note: You can combine display inputs with other display inputs: *P3D*P4D*IA*N

S E C U R E F L I G H T S E A R C H

You can search for PNRs, which require Secure Flight Passenger Data but do not contain the necessary information. Search results can be returned
in either:

 List Display: You can display non-compliant PNRs from the list for your immediate action.

 Printed List: You can print the list containing non-compliant PNRs to your Sabre system printer for further manual action

These features do not require activation.

S E C U R E F L I G H T S E A R C H A N D L I S T
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The following entries find SFPD non-compliant PNRs and display the results in a list on your screen.

Note: Use either FD (Flight Date) or TD (Ticket Date)

Search non-compliant PNRs, scheduled for ticketing in a specific month *SF¥-/(TD)-(3 character code of month)
*SF¥-/TD-MAY

Search non-compliant PNRs scheduled for ticketing in a date range *SF¥-/(TD)-(ddmmm)-(ddmmm)
*SF¥-/TD-27JUL-29AUG

Search non-compliant PNRs departing on a specific date * SF¥-/(FD)-(ddmmm)
*SF¥-/FD-27JUL-29AUG

Search for non-compliant PNRs for a specific carrier in a date range *SF¥-(airline code)/FD-(ddmmm)-(ddmmm)

*SF¥-DL/FD-29JUL-31JUL

S E C U R E F L I G H T S E A R C H A N D P R I N T L I S T

The following entries find SFPD non-compliant PNRs and send the results to a designated Sabre system hardcopy printer.

Notes:

 The printer must be a Sabre system hardcopy designated printer with an assigned Sabre system line address.
 Use either FD (Flight Date) or TD (Ticket Date) and never both in one entry.

 You cannot view the results on the printout

Display help on accounting lines for a non-air reportable document AC*DOC

Search non-compliant PNRs on flights departing on a specific date
between certain times and send the results to a Sabre system hardcopy
printer

PTR*SF¥-/FD-(ddmmm)-(ddmmm)
PTR*SF¥-/FD-29MAY1100-1200

Search non-compliant PNRs on a specific carrier in a flight date range
and send the results to a Sabre system hardcopy printer:

PTR*SF¥-(carrier code)/FD-(ddmmm)-(ddmmm)
PTR*SF¥-DL/FD-29MAY-17JUN

S E A R C H A N D Q U E U E P L A C E M E N T

Add an air ticket accounting line if you have previously issued a ticket and for some reason you lost the automated accounting line the system has
generatedThe following entries search non-compliant PNRs and send them to a specified queue for future action

 Include the queue number

 The system can place the PNR on a Branch Access queue

 You may specify a Prefatory Instruction Code (PIC), otherwise, the system adds PIC 19 LIST by default

Search PNR on flights departing on a specific date, and time. Place
results on queue 28

*SF¥-/FD-(date)(departing time)- (arriving time)/Q/(queue number)
*SF¥-/FD-29MAY1100-1200-Q/28

Note: The system sends the search results directly to the specified
queue.

System response:

SF¥-/FD-29MAY1100-1200-Q/28
QUEUE PLACEMENT IN PROGRESS
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PNR Transactions
Quick Reference

E N D T R A N S A C T I O N F O R M A T

Use these formats to complete and store any changes you make to a Passenger Name Record (PNR). You must complete all mandatory
PNR fields (PRINT) before you end a new PNR.

E
End transaction

ER
End transaction and redisplay the PNR

EM
End transaction and send an email message to the traveler about
the PNR via TripCase, provided the e-mail address field is present
in the PNR.

U P O N E N D I N G T R A N S A C T I O N

1 BA 192Y 23NOV S DFWLHR HK1 520P 800A /DCBA*KXM4YE /E

The action/status code SS (seats sold)
returned by the airline as a result of your sell
message will change to HK provided it is
confirmed.

Airline Record Locator: The Sabre system interacts with the airline
system and as a result a PNR is created in both the airline and the
Sabre system, generating a Sabre record locator and an airline
record locator.

Note: There are different action/status codes that a carrier or vendor can return to an itinerary segment. They indicate that space is
confirmed, waitlisted, cancelled or on request, schedule changes etc. Access Format Finder and type “Overview Status Codes” or
“Overview Action Codes” in the search request to access information about these codes.

I G N O R E P N R F O R M A T

Use these formats to ignore a PNR. This action removes any changes This action removes any changes that you made since the last time
that you ended the record.

Ignore returns an existing PNR to the database without changes (if I
the PNR was previously ended)

Ignore and re-display the PNR IR
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D I S P L A Y P N R F O R M A T

Display PNR using the Sabre record locator *(record locator)

*RDSQXT

Display PNR by passenger last name *-(last name)

*-MEYER

Display specific PNR from similar name list. A similar
name list appears when there are multiple PNRs with the
same or similar names.

*(PNR list number)

*3

Similar Name List example response:

Display PNR by passenger last name and travel date.isplay
PNR by passenger last name and travel date.

*-WALKER«
1 WALKER/JONI 03SEP-03SEP 2 WALKER/MISSY X -15MAR
3 WALKER/JOHN X -21APR

*-(travel date)-(last name)
*-15NOV-LOPEZ

Display PNR by confirmed flight number, date, and
passenger last name

*(carrier code)(flight number)/(travel date)-(last name)
*AA82/2NOV-DEXTER

Display branch office PNR by passenger name *-(pseudo city code)-(last name)
*-RD02-CARVALHO

R E - D I S P L A Y S P E C I F I C P N R
F I E L D S

You can display the complete PNR, or select specific fields of the PNR by using the corresponding field identifier as follows.

Display all fields
*A

Display only airline general facts (GFAX)
information

*P3

*N
Display the name field only Display only American Airlines facts (AFAX)

information

*P4

*I
Display the entire itinerary Display all remarks

*P5

Display itinerary air segments only
*IA *-

Display Form of Payment remarks only

Display itinerary car segments only
*IC *¥

Display Itinerary remarks only

Display itinerary hotel segments only
*IH *.

Display Invoice remarks only

*T
Display ticketing field only Display historical remarks

*P5H
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Display Frequent Flyer information
*FF

Display the received from and signature line
*P6

Display passenger e-mail information
*PE

Display the ticketing field only
*P7

*H
Display PNR history data Display the phone field only

*P9

Combination entry to display selected
fields only

*(field)*(field)*(fiel
d)
*N*IA*P9

4 Sabre Inc. All rights reserved. Sabre, Sabre Holdings, and Sabre Travel Network are trademarks and/or service marks of
an affiliate of Sabre Holding Corporation. All other trademarks, service marks, and trade names are the property of their

respective owners. 1.3 Page | 3
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Enhanced PNR Search and List
Quick Reference

E N H A N C E D P N R S E A R C H A N D L I S T - P O W E R B U S I N E S S P E R F O R M A N C E

O V E R V I E W

The Enhanced PNR Search Display improves quality and quantity of the content returned in the new PNR Name List Display, making it easier to
quickly identify the PNRs you need.

 This feature returns a list containing a maximum of 250 PNRs. If the maximum is exceeded, you will receive an error response. In order to
locate the PNR, you must refine your search criteria with a combination of different parameters.

 Applies to standard PNRs as well as Corp PNRs (C/), BSG and Associated PNRs (B/), Infant Names

 Allows you to easily alternate between search methods; Exact Name, Similar Name, or Wildcard

 New functionality allows you to search PNRs by phone, email address, frequent flyer number, profile index and active and cancelled status.
Also you can search for PNRs across all branches using the Enhanced PNR Search and List capabilities.

B E N E F I T S

Improves efficiency – Enables you to speed up the PNR Search process by introducing new parameters.

Increased productivity – You can combine new content searches with existing search parameters to find the PNR more quickly

Streamline workflow – Search results are more accurate in containing the PNRs returned in the response

E N H A N C E D S I M I L A R N A M E S E A R C H

Enhanced Search with Similar Last Name *¥-(Last Name)
*¥-MCCARTHY

Enhanced Search with Similar Last name and First Name *¥-(Last/First Name)
*¥-HEIDMAN/HILDA

Enhanced Search with Similar Last Name in a specific PCC *¥-(PCC)-(Last/First Name)
*¥-9RR1-MCCARTHY/HILDA

Enhanced Search with Similar Last Name across all Branches *¥-(XXXX)-(Last/First Name)
*¥-XXXX-MCCARTHY/HILDA

Enhanced Search by date and name *¥-(date)-(name)
*¥-25JUL11-JOHNSON/B

Enhanced Search with city pair, time and name *¥-(date)(city pair)(time)-(name)
*¥-24JULDFWMIA11A-KING

Notes:
 Date indicator is optional

 If you do not include the date, the system defaults to today

 If an exact match is not found, the result is an Enhanced Similar Name List.

 Specify XXXX to search for PNRs across all branches
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E N H A N C E D E X A C T N A M E S E A R C H

Add a qualifier "N" at the beginning of the input to indicate to search on exact name.

 This qualifier may be used with any search format that includes a name.

 If the system does not find any exact name, you receive the following response:

NO EXACT MATCHES FOUND

 If an exact match is not found, the result is an Enhanced Similar Name List

D E S C R I P T I O N F O R M A T

Search for PNR with exact name *¥N-(name)
*¥N-JOHNSON

Search for PNR with exact name in a specific Branch *¥N-(PCC)-(name)
*¥N-9RR1-JOHNSON

Search for PNR with exact name across all Branches *¥N-XXXX-(name)
*¥N-XXXX-JOHNSON

Search for PNR with specified origin and destination with exact name *¥N-/(city pair) - (last name)/(first name)
*¥N-/HNLDFW-WILSON/JOHN

Search for PNR with specified origin and destination during a specific month
with exact name

*¥N-(month)/(city pair)-(last name)
*¥N-OCT/HNLDFW-SMITH

E N H A N C E D W I L D C A R D S E A R C H

This search is based on names that start with the character string listed in the input

 Wildcard indicator is the ¥ (Cross of Lorraine), and can be used once in the input; either in the surname field or the first name field.

 If you use a wildcard in the last name field, you may not include a first name.

 You must include at least 2 characters before the use of the wildcard indicator.

 You do not need to enter any additional characters after the wildcard (i.e. SM¥TH)

 You are allowed to use name prefixes, e.g., C/

D E S C R I P T I O N F O R M A T

Search PNR using wildcard in last name *¥-(name)(¥)
*¥-WILS¥

Search PNR using wildcard in first name *¥-(last name)/(first name or partial name)(¥)
*¥-WILSON/JOH¥

Search PNR using wildcard in a specific Branch *¥-(PCC)-(partial name)¥
*¥-9RR1-WILS¥

Search PNR using wildcard across all Branches *¥-(XXXX)-(partial name)¥
*¥-XXXX-WILS¥
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S E A R C H P N R S B Y P N R S T A T U S W H E N U S I N G N A M E S E A R C H

Search for PNR by PNR Status (active or cancelled)

Note:

*¥-(last name)/(first name)-(A/X)
*¥-TYLER/ROBERT-A

 Specify A for active and X for cancelled

 The system determines that a PNR is active when PNR contains:

 at least one segment that a is flagged active, with the exclusion of
OTH segment if that is the only segment in PNR

 the passenger name specified in the search has not been
cancelled

 The system determines that a PNR is cancelled when PNR:

 contains no segments that are flagged active

 all segments are OTH segments

 the passenger name specified in the search has been cancelled

Search for PNR by PNR Status (active or cancelled) in a specific Branch *¥-(date)/(PCC)-(last name)¥/(first name)-(A/X)
*¥-20FEB/9RR1-TYLER/ROBERT-X

Search for PNR by PNR Status (active or cancelled), date and across all
Branches

*¥-(date)/(XXXX)-(last name)¥/(first name)¥-(A/X)
*¥-20FEB/XXXX-TYLER/ROBERT-X

E N H A N C E D P N R S E A R C H U S I N G A P H O N E
N U M B E R

F O R M A T

Search for all PNRs with a phone number

Note: You do not need to add hyphens between the phone numbers

*¥-(phone number)
*¥-6512142705

Search for PNR in a specific branch using a phone number and last name

Notes:

*¥-(date)/(PCC)-(phone number)
*¥-01MAR/B4T0-6512142705

 the system displays only those PNRs for which you have retrieval
rights through branch access and global branch access

 you cannot use the PCC and board/off points search parameters
together

Search for PNRs across all branches using date, name and phone number

Notes:

 the system displays only those PNRs for which you have retrieval
rights through branch access and global branch access

 you cannot use the PCC and board/off points search parameters
together

*¥-(date)/(XXXX)-(last name/first name-(phone number)
*¥-20FEB/XXXX-TYLER/ROBERT-6512142705
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S E A R C H B Y E M A I L A D D R E S S

Search by email address

Notes:

*¥PE¥-¥(email address)(¥)
*¥PE¥-¥TYLER.ROBERT@AOL.COM¥

 You can specify a partial or full email address

 You must include at least the email name and the at symbol (@)

 The domain can be omitted (for example johnsmith@)

 The email address is not case sensitive

 Email address fields cannot contain the following characters:
– Comma (,)
– Ampersand (&)
– Plus sign (+)
– Percent sign (%)

 The system cannot recognize the underscore character (_). If the e-mail
address contains an underscore, use two equal sign characters (==)
instead. For keyboards without an equal sign, use the Shift key plus the
hyphen (-).

 The system accepts the dash (-) symbol in an email address. You can
use it before or after the at symbol (@)

Search for PNRs using an email address in a specific Branch *¥PE¥-(date)/(PCC)-(last name)/(first name)-¥(email address)(¥)
*¥PE¥-20DEC/9RR1-TYLER/ROBERT-
¥TYLER.ROBERT@AOL.COM¥

Search for PNRs across all Branches using an email address *¥PE¥-(date)/(XXXX)-(last name)/(first name)-¥(email address)(¥)
*¥PE¥-20DEC/XXXX-TYLER/ROBERT-
¥TYLER.ROBERT@AOL.COM¥

S E A R C H B Y F R E Q U E N T F L Y E R N U M B E R

Search by frequent flyer number in the same PCC *¥FF¥-(airline code)(frequent flyer number)
*¥FF¥-QF2693921

Search for PNRs in a specific Branch using a frequent flyer number *¥FF¥-(date)/(PCC)-(last name)/(first name)¥-(airline code)
(frequent flyer number)
*¥FF¥-15DEC/9RR1-TYLER/ROBERT¥-QF2693921

Search by frequent flyer number across all Branches *¥FF¥-(date)/(XXXX)-(last name)/(first name)¥-(airline code)
(frequent flyer number)
*¥FF¥-15DEC/XXXX-TYLER/ROBERT¥-QF2693921

Enhanced PNR Search Quick Reference Page | 4



Passenger Name Records workbook page 49

S E A R C H B Y P R O F I L E I N D E X N U M B E R

Search by Profile Index number

 The following are the available profiles types for PNR search:

 Agency – AGY, Traveler – TVL, Corporate – CRP, Group – GRP,
Operational – OPX

*¥PI¥-(Profile type)/(Profile Index Number)
*¥PI¥-TVL/4075285345

Search for PNRs in a specific Branch using a Profile index number *¥PI¥-(PCC)-(Profile type)/(Profile Index Number)
*¥PI¥-F5VE-TVL/4075285345

Search for PNRs across all Branches using a Profile index number
*¥PI¥-(XXXX)-(Profile type)/(Profile Index Number)
*¥PI¥-XXXX-TVL/4075285345

A D D I T I O N A L R E F E R E N C E S

Find more information on Enhanced PNR Search in Format Finder.
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Pre-Reserved Seats
Quick Reference

D I S P L A Y S E A T M A P S

Use the formats below to display seats available for requests and aircraft configuration for those carriers that participate in the Sabre® Interactive
Pre-Reserved Seats (PRS) program..

Display seat map for a specific segment

Note: You must have a Passenger Name Record (PNR) displayed in
your work area to display a seat map.

4G(segment number)*
4G1*

Display seat map by carrier, flight number, class and date 4G*(carrier code)(flight number)(class of service)(date)(city pair)
4G*LH1364F2NOVLGALHR

S E A T M A P E X A M P L E

The response shows the first screen of the requested seat map. Use ¤MD or ¤MU to change screens for Direct Access seat maps.

Note: If you are a Sabre® Red™ Workspace user the system automatically launches the Graphical Seat Map based on carrier’s participation. See
Graphical Seat Maps Quick Reference.
DL RESPONSE
864Y 25OCT DFWSLC SEATS INVENTORY DETAIL

M90-Y1/SHIP 000
M90 DELTA MD90 Y-138 SEATS ECONOMY CLASS

....................
10 . . -BLKHD- . . .
11P A B C D E
12P A B C D E
13 A B C D E
14 A B C D E
15 A B C D E
16 A B C D E‡

AVAIL: SEAT LETTER LEAST PREF: SMOKING:S BULKHEAD:
TAKEN: . UPPER DECK: NOSMOKE:N WING ://
BLOCK: HANDICAP : BUFFER : EXIT ROW:EX
PREFERRED:P

Each airline’s seat maps appear
differently and use different symbols.
The legend at the bottom of each
map will help you decode the
symbols

R E Q U E S T S E A T S F O R M A T S

Request seats for all segments and all names using a preferred location
code.

Note: Location codes are: A: Aisle, B: Bulkhead, F: Front, L: Left side,
R: Right side, T: Tail, W: Window, X: Opposing Aisle seats

4GA/(location code)
4GA/W

Request seats for a specific segment and name number using a
preferred location code.

4G(segment number)/(location code)-(name number)
4G1/A-1.2

Request specific reserved seat for a specific segment and name number 4G(segment number)/(seat number)-(name number)
4G1/17A-1.3

Request two specific seats on different rows for one segment. 4G(segment number)/(seat number)(seat number)
4G3/14A15A
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Request multiple seats on the same row for specific segment 4G(segment number)/(seat numbers)
4G3/15AB

Request seats for non Sabre® Interactive Pre-reserved Seats carriers.
Send an SSR using GFAX or AFAX

3(service code)(segment number)/
(free text)-(name numbers)
3NSST1/AISLE-1

H O L D I N G R E S E R V E D S E A T S

When you request a seat, the itinerary segment is tagged “HRQ” while the seat is awaiting confirmation. Once the carrier has confirmed the seat, the
tag is updated to show “HRS”

1 DL 864Y 25OCT J DFWSLC HK1 846A 1039A HRQ /E

When you display the seat assignments the status “PN” (pending) changes to “KK” once the airline has confirmed the seats

SEATS/BOARDING PASS
1 DL 864Y 25OCT DFWSLC PN 11A 1.1 TEST/SEATS

When you redisplay the PNR, the signature line is appended with a “B” to indicate that a seat has been reserved or requested

B9P0.B9P0*ALD 1541/05OCT00 RPZCZG  B

C A N C E L S E A T S

Cancel seat assignments for a specific segment 4GX(segment number)
4GX1

Cancel seat assignments for a specific segment only for specified name
number.

4GX(segment number)-(name number)
4GX1-1.2

Cancel all seats for the entire itinerary. 4GXALL

D I S P L A Y S E A T S

Display the Pre-Reserved Seats PNR field. *B

A D D I T I O N A L R E F E R E N C E S

 Find additional Seats formats in the Format Finder help system. Access the Seats Topics from the Home page

 Display Seat Information in the Direct Reference Systems (DRS) to verify a specific carrier’s requirements and level of participation in the
Seats program. (Access DRS pages in Agency eServices under the Business Tools tag)

 Type N*/SEAT in the Sabre® system to find procedure to follow when seat requests are not confirmed
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Graphical Seat Map
Quick Reference

I N T R O D U C T I O N

Graphical Seat Map is an easy, user-friendly feature that allows you to pre-reserve seats by clicking the interactive display maps. The seats are
labeled and color-coded to indicate availability, and show any previous seat assignments for passengers in the itinerary.

Seat maps may not be available for all flights and/or airlines. In the case where the airlines do not provide graphical seat maps, the regular system
seat maps are displayed. If a seat map is available for a flight, you can select seats for a maximum of nine passengers on a maximum of eight flights
in a single itinerary.

You can display the Graphical Seat map using the long format, even if there is no PNR present.

You can only request seats on segments with a status code SS, HK, TK, SC, KK, or RR.

T U R N O N / O F F

Turn on/off interactive screen functionality:

 Click Tools in the Sabre® Red™ Workspace menu bar.

 Select Options

 The default option is to have the functionality ON (checkmark shows).

 To turn off the Graphical Seat Map, click the checkmark to remove it from the check box.
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D I S P L A Y T H E G R A P H I C A L S E A T M A P F O R M A T

Display the Graphical Seat map when the functionality is ON 4G (segment number)*
4G1*

Display the Sabre System Seat Map when the functionality is ON 4G (segment number)*/O
4G3*/O

Display the Graphical Seat map when the functionality is OFF 4G (segment number)*/G
4G1*/G

Display the Graphical Seat map with Point and Click when the
functionality is ON

Click the desired flight number booked in the itinerary.

If the carrier supports Graphical Seat Map, the feature opens in the
Horizontal Assistant Tool Panel

Display the Graphical Seat map when the functionality is ON, but you
have no PNR.

4G*(carrier code)(flight number)(class of service)(date)(city pair)-(zone
indicator)
4G*DL864Y18NOVDFWCDG-AN

H O W T O U S E T H E G R A P H I C A L S E A T M A P

To use this interactive feature, type the desired Seat number, or click the desired seat in the diagram.

The seat map display shows the following flight information:

 Flight Number

 Itinerary

 Aircraft model and manufacturer

 Interactive seat map (with airplane’s layout and explicatory diagram)

 Passengers by name

 Date

The feature automatically requests seats in the host system at several points during the booking. Seat requests are processed every time you:

 Click a different flight number tab

 Click Next Flight
 Click Previous Flight
 Click Save & Exit
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H O W T O U S E T H E G R A P H I C A L S E A T M A P

Once you input the desired display format, Graphical Seat Map appears in the Horizontal Assistant Tool Panel.

Note: Graphical Seat Map disables exit rows for all passengers in a PNR when one of the passengers is a child

T A S K D E S C R I P T I O N

Select Seat Assignment Seats available are shown in green. Click the desired seat in the aircraft
map.

To scroll up and down the plane diagrams, click the arrows above and
below the map.

Select Seat Assignment for multiple passengers After the seat for the first passenger is assigned, the system
automatically moves the active area to the next person’s seat
assignment. The passenger you are selecting seats for appears
highlighted.

You should select seats for all passengers for each flight to avoid errors
at End Transaction of the PNR.

Select seat Assignment for Multiple flights To move to the next flight, select the tab with the desired flight number.
Or
Click Next Flight.

Graphical Seat Map Quick Reference Page | 3



Passenger Name Records workbook page 55

T A S K D E S C R I P T I O N

Finish Seat Assignment Click Save & Exit.

Note: when the Graphical Seat map screen closes, the Sabre Work
Area screen automatically displays with the *B*P3 entry. Pre-reserved
s
eats are shown in Sabre format.

Choose Seat Assignment for Multiple flights with mixed itinerary
(Graphical Seat Map supporting and non-supporting carriers)

The interactive seat map displays the graphical seat map for all
supported segments. The system defaults to the Sabre host seat display
for all unsupported segments.

Cancel the selection Click Cancel.

Seat selection is ignored, the secondary work area closes, and the Sabre
Work Area screen is displayed with *B*3P entry.

Move forwards and backwards between the different flights Click Previous Flight or Next Flight

Or

Select the tab with the desired flight number.

Reserve a seat when there is a change-of-gauge segment, but there is
no equipment change (the aircraft only makes a stop, the equipment type
is the same on both legs of the flight).

1. Type VI* in the Sabre work area. Verify that the equipment is the
same type for both portions of the change of gauge flight.

2. Type the command to reserve seats: 4G (segment number)*.
Graphical Seat maps opens in the Sabre Red Workspace Horizontal
Assistant Tool Panel.

Note: A warning message displays: “This is a multi-segment flight. Only
the seat map for the first segment is displayed”.

3. Click the Close button and continue requesting seats on the
displayed seat map.

Reserve a seat when there is a change-of-gauge segment (where the
aircraft makes a stop and the equipment type is different for each leg of
the flight) with one or more non-participating carriers.

Two separate entries are needed to assign different seat numbers on
each leg of the segment.

1. Use the 4G(segment number)*/C entry in the Sabre Work Area to
view the system seat map for the originating portion of the flight and
request seats.

2. Use the override command 4G(segment number)*/O in Sabre Work
Area to view the system seat map for the secondary portion of the
flight and request seats.

Reserve a seat when there is a change-of-gauge segment (where the
aircraft makes a stop and the equipment type is different for each leg of
the flight) with participating carriers.

Map displays with the change of gauge segment showing as a regular
flight.

Graphical Seat Map Quick Reference Page | 4
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U N I T E D A I R L I N E S E N H A N C E D G R A P H I C A L S E A T M A P

Choose the perfect seat attributes from the new interactive enhanced seat maps. Access detailed seat characteristics and expanded cabin layouts.

View specific direction and angles of the seat (if facing forward,
backwards or if flatbed seat

View detailed representation of cabin layouts (upper deck, galley, stairs,
closet, exit row, lavatory, etc.)

Graphical Seat Map Quick Reference Page | 5
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Basic Pricing
Quick Reference

O V E R V I E W

Sabre® Air Pricing utilizes the latest technology to offer the most comprehensive, automated, foreign domestic and international pricing package of
any global distribution system worldwide. Accuracy, content, and efficiency are three critical components vital to air pricing. With over one billion fare
constructions available, Sabre Air prices complex itineraries quickly and accurately, offering you increased pricing flexibility and efficiency. By
choosing Sabre Air pricing, you can be confident that you are getting the best fares for each trip.

P R I C E T H E I T I N E R A R Y

Sabre Air Pricing (WP) – returns the lowest fare for the itinerary as booked. Sabre Air Pricing automatically prices the entire itinerary to a maximum
of 24 segments for your adult passenger. The system makes the following assumptions when you price an itinerary:

 all passengers in the PNR are adults

 all segments are to be priced

 you want the price for all passengers

Price current itinerary as booked WP

Redisplay last pricing response WP*

I N T E R P R E T T H E R E S P O N S E

North American pricing response example:

Departure Date
WP«

Total tax amount Last Day/time to Purchase (for
an advanced purchase fare)

Number of passengers
being priced; Base fare
currency code and amount

Tax Breakdown with
amounts and codes

Endorsement
information

23DEC DEPARTURE DATE-----LAST DAY TO PURCHASE 13DEC/2359
BASE FARE EQUIV AMT TAXES/FEES/CHARGES    TOTAL

1- USD2375.00      NGN475000     174581XT       NGN649581ADT

XT    111441YR      29322NG      10000QT       4000TE
7080US       1100YC       1400XY       1000XA
2240AY       2650FR       3448QX        900XF

2375.00         475000     174581            649581TTL
ADT-01 KHPXAFW4 BFFNG
LOS DL X/E/ATL DL NYC M696.50AF X/E/PAR AF LOS M1678.00NUC
2374.50END ROE1.00 XFJFK4.5

REFUNDABLE WITH FEE/CHANGE FEE APPLIES
VALIDATING CARRIER - DL
ALTERNATE VALIDATING CARRIER/S - AF

Total fare amount for all
passengers at this
passenger type (ADT)

Fare Calculation line;
See explanation below

Fare Calculation line explanation:
See Validating Carrier section of this document.

The customer is originating in LOS (Lagos) on DL (Delta Airlines) traveling to NYC (New York). The base fare from LOS to NYC is 969.50 and the
fare basis is KHPXAFW4. The customer then returns on AF (Air France) from NYC to LOS on fare 1678.00 with  fare basis BFFNG.

The total base fare for the trip is 2374.50. END indicates the end of the fare calculation. XFNYC4.5 indicates the PFC (Passenger Facility Charge)
for the itinerary.
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European/international pricing response example:
Departure Date

WP«
Total tax amount Last Day/time to Purchase (for

an advanced purchase fare)

Number of passengers
being priced; Base fare
currency code and amount

Tax Breakdown with
amounts and codes

Endorsement
information

23DEC DEPARTURE DATE-----LAST DAY TO PURCHASE 13DEC/2359
BASE FARE      EQUIV AMT TAXES/FEES/CHARGES    TOTAL

1- USD2375.00      NGN475000     174581XT       NGN649581ADT

XT    111441YR      29322NG      10000QT       4000TE
7080US       1100YC       1400XY       1000XA
2240AY 2650FR       3448QX        900XF

2375.00         475000     174581            649581TTL
ADT-01 KHPXAFW4 BFFNG
LOS DL X/E/ATL DL NYC M696.50AF X/E/PAR AF LOS M1678.00NUC
2374.50END ROE1.00 XFJFK4.5

REFUNDABLE WITH FEE/CHANGE FEE APPLIES
VALIDATING CARRIER - DL
ALTERNATE VALIDATING CARRIER/S - AF

Total fare, currency code,
and amount for all
Passengers at this
passenger type (ADT)

Fare Calculation line;
see explanation below

See Validating Carrier section of this document.
The price displays in the currency of the departure city. If your location has a different currency, the display includes an EQUIV AMOUNT column
with the amount in the currency of your location.

Display the fare calculation description WPDF

Display description of a specific fare calculation line WPDF(line number from WP response)
WPDF2

Redisplay description of a fare calculation line WPDF*

Note: Fare calculation line display includes a description of each fare element, pricing unit (PU) number and pricing unit trip type, surcharges, taxes,
rates of exchange, global indicator, one-way versus half-round, stopover charge, minimum fare check, NUC amount, and BSR (bankers’ selling rate).



Sabre Air Pricing Workbook Page | 6

Air Extras

 A growing trend in the travel market is the “unbundling” of
fares which result in airlines offering optional services to
travelers for a fee; examples are premium seats, checked
baggage and meal fees. Sabre Air Extras provide you with
tools to support your customer’s request of these services.

AIR EXTRAS AVAILABLE - SEE WP*AE

Note: See the “OB Ticketing Fees”,” Baggage Allowance”, and the
“Air Extras – Pricing Formats” quick references or the Format
FinderSM help system for more detail.

B A R G A I N F I N D E R

Search for an alternative lower price by checking other available booking classes for the itinerary in your PNR, within the same cabin. The system
shows the lowest fare available and advises the class of service in which the itinerary must be booked in order to get this fare. Do not use the
following formats to store your fare in a Price Quote (PQ) record:

Find lowest fare available for itinerary and advise booking code WPNC

Find lowest fare regardless of availability WPNCS

Find lowest fare available and re-book class of service WPNCB

Find lowest fare with secondary qualifiers and re-book class of
service

WPNCB¥(qualifier)¥(qualifier)¥ qualifier)
WPNCB¥PC03¥S1/2-4¥XR

P R I C E W I T H S E C O N D A R Y Q U A L I F I E R S

Use additional qualifiers to further define your pricing request. Separate multiple qualifiers with the cross of Lorraine (‡). See the Format Finder help
system for additional qualifiers.

Note: You can use secondary qualifiers with both basic pricing (WP) and Bargain Finder (WPNC) formats. When using qualifiers with WPNC
formats, place a cross of Lorraine (¥) between the WPNC/WPNCB/WPNCS and the first qualifier. For example: WPNCB¥PADT/C09¥S1/3.

Price a single segment WPS(segment number)
WPS3

Price multiple segments WPS(segment number)-(segment number)/(segment number)
WPS1-3/5

Price a single name:

Price multiple name

WPNC¥N(name number)
WPNC¥N2.1

WPNC¥N(name number)/(name number)-(name number)
WPNC¥N1.1/3.1-3.5

Price a single passenger type: WPNCB¥P(passenger type)
WPNCB¥PC05

Price multiple passenger types WPP(passenger type)/(passenger type)/ (passenger type)
WPPADT/C05/INF

Price a single passenger type and ensure the response is for that
passenger type only, even if there are lower fares

WPP(passenger type)¥XO
WPPJCB¥XO

Note: See the Format Finder help system for a list of passenger type codes. When using multiple passenger type codes, enter the codes in the
same order as the passenger names in the PNR.
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Price with Negotiated Fare Pricing indicator (corporate ID code) WPI(corporate ID code)
WPIBOE01

Price with account code WPAC*(account code)
WPAC*ACCTCODE1

Note: You can price using up to 4 corporate ID codes or 4 account codes in one entry. You may also price using a combination of up to 4 corporate
ID codes and account codes in one entry. See the Multiple Corporate IDs and Account Codes quick reference for more information and formats.

Price with the validating carrier code

Note: Pricing does not look for alternate or neutral validating
carriers in this instance. See the Validating Carrier section of this
document for more details.

WPA(validating carrier code)
WPALH

Price with Canadian hemisphere and journey codes WPH(hemisphere code) ¥J(journey code)
WPH2¥J2

Price with alternate currency WPM(currency code)
WPMEUR

Price and exempt all taxes and fees
Price and exempt all taxes, but collect fees

Price and exempt specific taxes

Price and apply specific amounts to specific taxes

WPTN
WPTE

WPTE-(tax code)/(tax code)/(tax code)
WPTE-XG/FR/GB

WPTX(amount)(tax code)/(amount)(tax code)
WPTX5.20XU/6.40RI

Note: These tax formats override system pricing. Check with the airline to avoid a debit memo.

Price as a public fare WPPL

Price as a private fare WPPV

Note: A paper ticket surcharge may be applied to ticket total if carrier has filed surcharge with Airline Tariff Publishing Company (ATPCO)

Price excluding penalty fares WPXP

Price excluding all restrictions

Price excluding fares with advance purchase

WPXR

WPXA

Combine multiple pricing qualifiers in one entry.

Note: Use a cross of Lorraine (¥) to separate multiple qualifiers

WP(qualifier)¥(qualifier)¥(qualifier)
WPPC03¥S2/4¥N1.2

Price current itinerary as booked and specify a buy (or back) date

Note: Dates must include a 2-digit year

WPB(date)
WPB19JUN07

Find lowest fare available, re-book class of service and specify a buy
(or back) date

WPNCB¥B(date)
WPNCB¥B19JUN07

Price a single segment and specify a buy (or back) date WPS(segment number)¥B(date)
WPS3¥B19JUN07

Price multiple segments and specify a buy (or back) date WPS(segment number)-(segment number)/(segment number)¥B(date)
WPS1-3/5¥B19JUN07

See the “Historical Fares and Pricing” quick reference for more historical pricing formats and information.
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V A L I D A T I N G C A R R I E R T E R M I N O L O G Y

Term Definition

Alternate Validating Carrier A marketing carrier who participates in the itinerary and returns the same fare
solution as the default/primary validating carrier.

Default Validating Carrier The validating carrier determined by the system using industry adopted
guidelines, identified in the ATPCO service fees.

GSA General Sales Agent - a carrier representing another carrier for ticketing in a
specific country and for a specific settlement plan. The GSA must have a
third party ticketing agreement with the carrier they are representing and all
other carriers participating in the itinerary for the system to consider them as
a validating carrier.

Interline Types Standard – (Formerly Normal) - An interline agreement exists between the
validating carrier and the carrier(s) in the itinerary. The validating carrier
must be a marketing carrier in the itinerary you are shopping/pricing/ticketing.

Third Party – (Formerly Hosted and Pseudo) - An interline agreement exists
between the validating carrier and the carrier(s) in the itinerary. The validating
carrier is not required to be in the itinerary as marketing or operating carrier.

Marketing Carrier The airline whose airline designator the system records as the transporting
carrier on the flight coupon(s).

Neutral Validating Carrier A carrier who does not participate in an itinerary and is not the GSA for any
marketing carrier in the itinerary, but has a third party interline ticketing
agreement with all marketing carriers in the ticketed itinerary.

Optional Validating Carriers Describes a condition when there are two or more neutral validating carriers
that the system can assign to the same lowest fare solution.

Validating Carrier The issuing airline whose numeric airline code precedes the document
number.

For more information on validating carrier logic, see the Format Finder help system or the “Electronic Ticket Types, Carrier Participation and
Validation Displays” quick reference.
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V A L I D A T I N G C A R R I E R D I S P L A Y S

In order for a travel agent to shop, price and issue any ticket (electronic or paper) the Sabre system performs the following validation checks:

1. The selected validating carrier participates in ticket issuance settlement plan, such as ARC or BSP.

2. The validating carrier allows you to issue the ticket with all marketing and operating carriers for the itinerary segments you are ticketing (interline
agreements).

3. Agency issuing the ticket has the authority to issue on the carrier’s behalf.

The system uses this validating carrier logic across Shopping, Pricing, and Ticketing, returning the lowest ticketable fare solution.

 The system performs validation check number 3 at the time of ticketing only.

Display list of all carriers that you can validate a ticket on in a WB*(mandatory two-character ISO country code for point of sale
specific country country)/1S/(optional three-character settlement method code)

WB*GB/1S/BSP
Note: 1S in the entry indicates prime host, (Sabre system) this is an
optional field.

Settlement Method codes and definitions:

BSP Billing and Settlement Plan – most common settlement
method.

RUT Russian Transitional Airline Ticket (TAT) – applicable to Aeroflot
(SU) stock only.

ARC Airline Reporting Corporation – settlement method used in
US/PR/VI

PRT Philippines TAT – applicable to Philippine Airlines (PR) stock
only.

TCH Transport Clearing House – settlement method used in
RU/XU

SAT Student Airline Ticketing Agreement

GEN Generic Transitional Airline Ticket – direct ticketing using a
specific airline’s stock.

KRY Student ticketing (Kilroy only).

Note: Display edited for document purposes. You may need to WB*GB/1S«
move down (MD) to see the entire response. SABRE VALIDATING CARRIERS FOR UNITED KINGDOM

***BILLING AND SETTLEMENT PLAN***
ELECTRONIC TICKETS ONLY
2J 4Q 6H 8M 8U 9B 9F 9U 9W A3 AA AB
AC AF AH AI AM AR AS AT AV AY AZ B2
BA BD BE BG BI BM BP BR BT BW CA CI
CM CX CY CZ DE DL DT DY EI EK ET EY
F7 FB FI FJ FV GA GF GL GR HA HM HR
HU HX HY IB IG IY IZ J2 JJ JL JP KC
KE KK KL KM KP KQ KU KX LA LG LH LN
LO LW LX LY MD ME MF MH MK ML MR MS
MU NH NX NZ OA OK OM OS OU OV OY OZ
P0 PC PG PK PR PW PX PY QF QR QV R2

NEUTRAL VALIDATING CARRIERS
AC AF AM HR KL LA MS NZ QR SU UT

***TRANSITIONAL AUTOMATED TICKET RUSSION***
PAPER TICKETS PREFERRED
SU

NEUTRAL VALIDATING CARRIERS
SU

***STUDENT TICKETING SATA***
ELECTRONIC TICKETS PREFERRED
2A 3K 4M 9B 9F 9W AB AC AM AR AV AY
AZ B6 BA BD BE BI BR BT CI CM CX CZ
DL EK ET EY FI FJ FV FZ GF HU JJ JQ
KA KC KE KQ KU LA LO LP LR LY MH MK
MS MU NH NZ OA OK OU OZ PG PR PX PZ
QF QR RJ S2 S7 SA SK SQ SU SW T0 TA
TG TK TN TP UL US UX VA VF VS WY XF
XL
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You may override the settlement plan in your pricing format

Note: When you specify a settlement method that is not valid for
your country, you receive this error message::

INVALID SETTLEMENT METHOD FOR POINT OF SALE

WBVM(three-character settlement method code)
WBVMGEN

I N T E R L I N E A G R E E M E N T D I S P L A Y

You can also display interline ticketing agreements between carriers. This information is helpful when a passenger travels on two or more carriers in
one trip and you need to know if you can combine all segments in one ticket.

Use the interline ticket agreement to determine:

 all the airlines with whom a particular airline has a ticket agreement

 all airlines that offer a ticket agreement to a particular airline

Display all interline agreements for the specified validating carrier in
the specified country

Note: The response includes the agreement type between the
carriers.

WBIA*(mandatory two-character validating carrier code)/(mandatory two-
character ISO country code for point of sale country)1S
WBIA*BA/GB/1S

Note: You may need to move down (MD) to see the entire
response.

WBIA*BA/GB/1S«
SABRE INTERLINE AGREEMENTS - BRITISH AIRWAYS P.L.C.
COUNTRY OF TICKET ISSUE - UNITED KINGDOM

SEE WETP*BA FOR ELECTRONIC TICKETING FUNCTIONAL CAPABILITIES

***PAPER TICKETS - ONLY***

5T 7H A9 JQ SS T0 VF WF XK XM

***ELECTRONIC TICKETS***

BA MUST HAVE ONE SEGMENT IN ITINERARY

3K 3U 4M 9W A3 AB AC AE AH AI AM AS
AT AV AY AZ B6 BE BI BL BM BP BR BT
BW CA CI CM CX CY CZ DL DT EC EI EK
ET EY FB FI FJ FV G3 GA GF GK HA HG
HM HU HX IG IR J2 JC JJ JL JP KA KC
KE KK KL KM KQ KU KX LA LG LH LI LP
LR LX LY ME MH MI MK MS MU MX NH NU
NZ OA OK OS OU OV OZ PG PR PW PX PZ
QF QM QR RB RJ RO S7 SA SB SN SQ SU
SV SW TA TF TG TK TM TN TP TU U7 UA
UL UN UP US UU VN VS VY WM WS WY XL

BA NOT REQUIRED IN ITINERARY

AA AF BD IB LO MN

A E F E R E N C E S
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Low Fare Search
Quick Reference

O V E R V I E W

Low Fare Search takes the guesswork out of locating lower fare options. One entry returns up to 19 low fare options for itineraries consisting of one-
way or round-trip journeys in all markets worldwide. The least expensive fare is always the first option.

Alternate airlines, times of day and inventory options can be booked directly from the response. In addition, you can use qualifiers to help tailor the
search for options that address customers’ specific needs and preferences; including qualifiers that allow you to request private fares or public fares
only.

U S I N G B A S I C Q U A L I F I E R S

Request new available itinerary with lower fare WPNI

Search for new itinerary, regardless of availability WPNIS

Request new available itinerary and specify number of responses (default
is 9)

WPNI¥Z(number of responses 1 to 19)
WPNI¥Z19

Request new available itinerary selecting certain segments WPNI¥S(segment)/(segment)/(segment)
WPNI¥S1/2/4

Redisplay last itinerary options WPNI*

Price itinerary using Low Fare Search (WPNI) and return all applicable brand
options (BRALL).

WPNI¥BRALL

Note: See the Branded Fares quick reference for more information.

S E L E C T I T I N E R A R Y O P T I O N S

Choose option from the list of alternative itineraries WC¥(item number from the list)
WC¥1

Choose option from the list of alternative itineraries and cancel current
itinerary

WC¥(item number from the list)X
WC¥1X

P R E M I U M C A B I N S H O P P I N G

Low Fare Search supports shopping for premium first, premium business, and premium economy cabins. Low Fare Search automatically determines
the premium cabin using the booking codes of the itinerary mapped to an internal carrier cabin database. You do not need to add a cabin qualifier to
your entry.

Pricing and Shopping defines the cabin primarily by the Reservation Booking Code (RBD) and Automated Rules Fare Types. Database tables exist
for both. The system maps RBDs to cabins in the Cabin table.

U S E S E C O N D A R Y Q U A L I F I E R S

Low Fare Search pricing formats with optional fields, such as preferred carriers, must precede any other regular optional pricing fields such, as
passenger type or segment select. Separate Low Fare Search formats from regular pricing formats with a cross of Lorraine (¥).

Combine multiple qualifiers WPNI/(qualifier)/(qualifier)/(qualifier)¥(qualifier)
WPNI/D/T3/ARGLA¥XP
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City and Airport Qualifiers

Request new available itinerary using same airports WPNIN

Request new available itinerary using current connect points WPNIX

Request new available itinerary searching multiple airports WPNIM

Carrier or Service Type Qualifiers

Request new available itinerary using specific carriers WPNI/A(carrier code)(carrier code)
WPNI/ALHKL

Request new available itinerary excluding specific carriers WPNI/X(carrier code)(carrier code)
WPNI/XTGAI

Request new available itinerary using direct flights only

Request new available itinerary and request additional non-stops

Notes:

 You can request a maximum of 50% additional non-stop options in your
response, for example, a maximum of 5 additional options for a request
of 10 options returned, or a maximum of 9 additional options for a
request of 19 options returned.

 Non-stop options are additive. For example, if you request 5 non-stop
options you receive your normal response options plus an additional 5
non-stop options.

Request new available itinerary and specify the maximum number of
connections (0-3) the customer is willing to make

WPNI/D
WPNI/NS-(number of additional non-stops)
WPNI/NS-5

WPNI/K(number of connections)
WPNI/K1

Request new available itinerary and enable long connections

Note: Applies to International itineraries only. Supplements regular
connections with long connections between 780 minutes (13 hours) and 1439
minutes (23 hours, 59 minutes); default is 780 minutes when not specified.

WPNI/LC-Y

Request new available itinerary and enable long connection with specific
number of minutes

WPNI/LC-Y(number of minutes)
WPNI/LC-Y840

Note: Applies to International itineraries only. Number specified must be
between 780 and 1439.

Request new available itinerary and specify minimum and maximum number
of minutes for long connection, no minimum or maximum number of
connections specified

Note: The system applies the default number of connections, which is “1”,
unless the carrier defines the rule setting differently.

WPNI/LC-Y(minimum number of minutes)-(maximum number of
minutes)
WPNI/LC-Y840-1200

Request new available itinerary and specify minimum and maximum number
of connections for long connection, no minimum or maximum number of
minutes is specified

WPNI/LC-Y*(minimum number of connections)-(maximum number
of connections)
WPNI/LC-Y*2-3

Request new available itinerary and specify minimum and maximum number
of minutes for long connections and minimum and maximum number of
requested connections

WPNI/LC-Y(minimum number of minutes)-(maximum number of
minutes)*(minimum number of connections)-(maximum number of
connections)
WPNI/LC-Y840-1200*2-3
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Request new available itinerary and specify only minimum number of minutes
for long connection and minimum number of connections

WPNI/LC-Y(minimum number of minutes)*(minimum number of
connections)
WPNI/LC-Y840*2

Request new available itinerary and specify only maximum number of minutes
for long connection and maximum number of connections

WPNI/LC-Y-(maximum number of minutes)*-(maximum number of
connections)
WPNI/LC-Y-1200*-3

Request new available itinerary and specify only minimum number of minutes
for long connection and maximum number of connections

WPNI/LC-Y(minimum number of minutes)*-(maximum number of
connections)
WPNI/LC-Y840*-3

Request new available itinerary and specify only maximum number of minutes
for long connection and minimum number of connections

WPNI/LC-Y-(maximum number of minutes)*(minimum number of
connections)
WPNI/LC-Y-1200*2

Request new available itinerary and specify online service only WPNI/O

Request new available itinerary and specify interline solutions only WPNI/MIX

Request new available itinerary, exclude interline itineraries where e-ticketing
agreements do not exist between marketing and/or operating carriers

WPNI/XSTI

Request new available itinerary and stay true to the cabin requested in the
shopping query and only return options in the requested cabin

WPNI/XJ

Shop by Alliance qualifiers

Use the qualifiers and formats below to search for a lower fare and request flights on a specific carrier alliance program.

Qualifier Alliance Name

*A Star Alliance

*O One World Alliance

*S Skyteam Alliance

Request new available itinerary and specify preferred (/A) alliance WPNI/A*(alliance code)
WPNI/A*O

Request new available itinerary and specify multiple preferred (/A) alliances WPNI/A*(alliance code)*(alliance code)
WPNI/A*O*A

Request new available itinerary and specify preferred (/A) alliance and
preferred carrier (*A)

WPNI/A*(alliance code)*A(carrier code)
WPNI/A*O*AAF

Request new available itinerary and specify non-preferred (/X) alliance WPNI/X*(alliance code)
WPNI/X*O

Request new available itinerary and specify multiple non-preferred alliances WPNI/X*(alliance code)*(alliance code)
WPNI/X*O*A

Request new available itinerary and specify non-preferred alliance and non-
preferred carrier

WPNI/X*(alliance code)(carrier code)
WPNI/X*OLH

Request new available itinerary, include (/A) and exclude (/X) alliances WPNI/A*(alliance code)/X*(alliance code)
WPNI/A*A/X*O
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Request new available itinerary and specify preferred alliance and non-
preferred carrier

Note: Returns alliance carriers yet excludes itinerary options with specified
non-preferred carriers.

WPNI/A*(alliance code)/X(carrier code)
WPNI/A*S/XAF

Request new available itinerary and specify preferred carriers and non-
preferred alliance

Note: Returns carrier itinerary options that pertain to the indicated preferred
carrier codes, excluding itinerary options containing specified non-preferred
alliances.

WPNI/A(carrier code)(carrier code)(carrier code)(carrier
code)(carrier code)(carrier code)/X*(alliance code)
WPNI/AAFAZDLKLABAY/X*O

Day/Time Qualifiers

Request new available itinerary within specified number of hours from the
current itinerary

WPNI/T(number of hours)
WPNI/T3

Note: The maximum number of hours is nine.

Request new available itinerary on a specified number of days later than the
current itinerary (plus days)

WPNI/P(number of days later)
WPNI/P2

Request new available itinerary on a specified number of days sooner than the
current itinerary (minus days)

WPNI/M(number of days sooner)
WPNI/M2

Request new available itinerary and search arrival time range

Note: The system returns only those options in the range.

WPN¥ZRA(arrival time range)
WPNI¥ZRA09001400

Request new available itinerary and search departure time range

Note: The system returns only those options in the range.

WPNI¥ZRD(departure time range)
WPNI¥ZRD12001500

Request new available itinerary and specify the number of hours to search
back to for all segments.

 For example, if you specify 48, the system searches up to 48 hours prior
to the requested arrival date and time.

Note: Minimum 1 digit, maximum 2 digits. Minimum 1 hours, maximum 72
hours. You cannot combine ZRR with ZRA, ZRD or T.

WPNI/ZRR(number of hours)
WPNI/ZRR48

Request new available itinerary and specify arrival time range (hours in the
past) for specific segments.

Note: You may specify only 1 segment per leg (one for outbound segment
and one for inbound segment) for a maximum of two *S qualifiers permitted per
entry. You cannot request a range of segments (for example, *S1-3, or *S4-7).

WPNI/ZRR(number of hours)*S(1 or 2 digit segment
number)/ZRR(number of hours)*S(1 or 2 digit segment number)
WPNI/ZRR48*S01/ZRR72*S06

Request new available itinerary and specify segment 1 and if there is a return
segment, return options for that return segment’s date

WPNI/ZRR(number of hours)*S1
WPNI/ZRR24*S1

Request new available itinerary for one segment only (ignores all other
segments)

WPNI/ZRR(number of hours)¥S(segment number)
WPNI/ZRR24¥S2

Note: Only one ¥S qualifier permitted per entry. You cannot combine ¥S
qualifier with the *S qualifier.
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Passenger or Fare Type Qualifiers

Request new available itinerary using a specified passenger type WPNI¥P(passenger type code)
WPNI¥PC08

Request new available itinerary using a specified passenger type and ensure
the response is for that passenger type only, even if there are lower fares

WPNI¥P(passenger type)¥XO
WPNI¥PJCB¥XO

Request new available itinerary using specified passenger type and corporate
ID

WPNI¥P(passenger type code)¥I(corporate ID)
WPNI¥PNEG¥IABC01

Request new available itinerary using specified passenger type, corporate ID
and Force a corporate fare

WPNI¥P(passenger type code)‡XC¥I(corporate ID)
WPNI¥PNEG¥XC¥IABC01

Request new available itinerary using an account code WPNI¥AC*(account code)
WPNI¥AC*ACCTCODE1

Request new available itinerary without:
penalties (XP)
advance purchase (XA), minimum/maximum stay (XS), any restrictions (XR)

WPNI¥(qualifier)
WPNI¥XP

Request new available itinerary and specify:
private fares only (PV), public fares only (PL)

WPNI¥PV
WPNI¥PL

Request new available itinerary and specify through fares WPNI/THRU

Request new available itinerary and specify passenger status as:
employee (EM)
resident (RY)
national (NT)

WPNI¥(passenger status code)/(country code)(state code as
applicable
WPNI¥RY/AU

Sales/Ticketing/Tax Qualifiers

Request new available itinerary for fares effective on specific date WPNI¥B(date)
WPNI¥B01AUG

Request new available itinerary and validate on a specific carrier WPNI¥A(carrier code)
WPNI¥ALH

Request new available itinerary and specify a currency override WPNI¥M(3-character currency coder)
WPNI¥MGBP

Request new available itinerary and specify a currency override for domestic
travel within dual currency countries

WPNI¥D*(3-character currency coder)
WPNI¥D*PLN

Request new available itinerary and override a point of sale WPNI¥S(city code)
WPNI¥SFRA

Request new available itinerary and override a point of ticketing WPNI¥T(city code)
WPNI¥TCPH

Request new available itinerary and exempt taxes (PFCs are still included) WPNI¥TE

Request new available itinerary and specify a tax to be included in the request WPNI¥TX(tax amount)(tax code)
WPNI¥TX10.00GB

Request new available itinerary and exempt taxes and fees (PFCs are still
included)

WPNI¥TN
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Alternate Cities Qualifiers

Search up to five origin and/or destination cities/airports.

Note: The system considers your primary origin/destination cities as one of the 5 cities. Therefore, you may add up to four (4) alternate cities in the
format.

for the origin or destination, specifying each city WPNI/*AC-(first origin or destination city)*(second alternate
city)(third alternate city)(fourth alternate city)(fifth alternate city)
WPNI/*AC-LAX*LGBONTSNABUR

for alternate cities at both the origin and destination, specifying both cities WPNI/*AC-(first origin city)*(second alternate city)(third alternate
city)(fourth alternate city)(fifth alternate city)*(first destination
airport)*(second alternate city)(third alternate city)(fourth alternate
city)(fifth alternate city)
WPNI/*AC-LGA*JFKEWRHPNISP
*LAX*BURSNAONTLGB

Search for alternate cities for the origin or destination by specifying a mileage
radius. Maximum distance is 100 miles.

WPNI/*AC-(destination city)*(mileage radius)
WPNI/*AC-MEX*100

Search for alternate cities at both the origin and destination, specifying the
mileage radius. Maximum distance is 100 miles.

WPNI/*AC-(origin city)*(mileage radius)*(destination city)*(mileage
radius)
WPNI/*AC-YVR*100*ORD*50

for the origin, for a specific segment, specifying each city WPNI/*AC-S(segment)(first origin city)*(second alternate city)(third
alternate city)(fourth alternate city)(fifth alternate city)
WPNI/*AC-S1YYZ*YTZYKZYHM

Specify a segment mileage radius for an alternate city WPNI/*AC-S(segment number)(city to replace)*(mileage radius)
WPNI/*AC-S2YVR*100
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Enhanced Rule Display
Quick Reference

O V E R V I E W

The Enhanced Rule Display (WPRD* and WQRD*) provides an alternative to viewing fare rules from a priced itinerary. With the enhanced rule
display, you can view rules of fares that the system prices, thus removing potential guesswork; this function provides you with the fare rules or the
pricing unit/fare component breakdown for easy access to each fare rule.

The WPRD* command allows you to display fare rules following any of the following pricing commands:

 WP

 WP*

 WPQ

 WPA

Note: Enhanced rule display is valid following a WPNI/JR/JA command, but only after you have displayed the pricing response (you have selected
an option from the shopping offerings and have actually priced the chosen itinerary).

The WQRD* command allows you to display fare rules following a WQ command.

R E S P O N S E

The Enhanced Rule Display response may contain several lines and pages of rules. Use the MD/MB/MU/MT formats to view more

Enhanced rule display following a single fare components pricing
response.

WP«
20JAN DEPARTURE DATE-----LAST DAY TO PURCHASE 14DEC/1222

BASE FARE      EQUIV AMT TAXES/FEES/CHARGES    TOTAL
1- USD325.00    NGN65000    100421XT NGN165421ADT

XT     74800YQ       6990NG      10000QT       4000TE
4085AE        273TP 273ZR
325.00 65000     100421            165421TTL

ADT-01 TLEXPNG1
LOS EK DXB162.50EK LOS162.50NUC325.00END ROE1.00

NON-END/SAVER/ONLY CHK-IN REWARD UPGRADE

VALIDATING CARRIER - EK

WPRD*«
V FARE BASIS     BK    FARE   TRAVEL-TICKET AP  MINMAX  RTG
1   TLEXPNG1       T‡R    65000 E18JA  T22DE -/3  5/ 1M EH01

D15MR
PASSENGER TYPE-ADT                 AUTO PRICE-YES
FROM-LOS TO-DXB    CXR-EK    TVL-20JAN16  RULE-NGT5 IPRMEAF/34
FARE BASIS-TLEXPNG1          SPECIAL FARE  DIS-E   VENDOR-ATP
FARE TYPE-XES      RT-SPECIAL EXCURSION FARE
USD   325.00  0500  E18JAN16 D15MAR16   FC-TLEXPNG1  FN-25
SYSTEM DATES - CREATED 08DEC15/0420  EXPIRES INFINITY

50.RULE APPLICATION AND OTHER CONDITIONS
NOTE - THE FOLLOWING TEXT IS INFORMATIONAL AND NOT
VALIDATED FOR AUTOPRICING.
TACTICAL FARES FROM NIGERIA
APPLICATION
AREA
THESE FARES APPLY
FROM NIGERIA.

CLASS OF SERVICE
Enhanced rule display following a multiple fare components pricing
response.

WP«
20JAN DEPARTURE DATE-----LAST DAY TO PURCHASE

14DEC/1229
BASE FARE      EQUIV AMT TAXES/FEES/CHARGES    TOTAL

1- USD495.00   NGN99000    102121XT NGN201121ADT
XT     74800YQ       8690NG      10000QT       4000TE

4085AE        273TP        273ZR
495.00          99000     102121            201121TTL
ADT-01 MLXESNG1 TLEXPNG1
LOS EK DXB332.50EK LOS162.50NUC495.00END ROE1.00

NON-END/FLEX

NON-END/SAVER/ONLY CHK-IN REWARD UPGRADE

VALIDATING CARRIER - EK

Note: As the pricing response contains multiple fare components,
WPRD* must contain either segment select and/or fare basis code
qualifiers. If you do not use segment select and/or fare basis code
qualifiers, the system returns a fare component summary.

WPRD*«
WPRD*S1«

V FARE BASIS     BK    FARE   TRAVEL-TICKET AP  MINMAX  RTG
1   MLXESNG1       M‡R   133000 ---- - 3/ 4M EH01

PASSENGER TYPE-ADT                 AUTO PRICE-YES
FROM-LOS TO-DXB    CXR-EK    TVL-20JAN16  RULE-NG10 IPRMEAF/34
FARE BASIS-MLXESNG1          SPECIAL FARE  DIS-E   VENDOR-ATP
FARE TYPE-XES      RT-SPECIAL EXCURSION FARE
USD   665.00  0500  E21MAY15 D-INFINITY   FC-MLXESNG1  FN-
SYSTEM DATES - CREATED 20MAY15/0923  EXPIRES INFINITY

WPRD*S1

50.RULE APPLICATION AND OTHER CONDITIONS
NOTE - THE FOLLOWING TEXT IS INFORMATIONAL AND NOT
VALIDATED FOR AUTOPRICING.
STRATEGIC FARES FROM NIGERIA
APPLICATION
AREA
THESE FARES APPLY
FROM NIGERIA.

CLASS OF SERVICE
THESE FARES APPLY FOR FIRST/BUSINESS/ECONOMY CLASS ¥
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T A S K F O R M A T

Display a fare rule following any pricing format, except WQ WPRD*

Note: Certain format entry typos with WQ may cause the error response “UNABLE TO DISPLAY - PRICING DATA NOT SAVED” after WQRD
formats. If you receive this error response, please re-enter your original WQ format (with city pair, carrier information, etc.) and you should be able to
resume your WQRD commands.

Redisplay the last fare rule that you requested using an enhanced rule
display

WPRD**

Note: If you log into another pseudo city code (PCC), or 30 minutes elapse, the redisplay command is no longer valid.

Display a fare rule using a passenger type

Note: You can only request the fare rules for one passenger type at
any one time. The passenger type code is not valid following a WQ or
WPA response.

WPRD*P(passenger type)
WPRD*PMIL

When using the passenger type qualifier, always place it directly after the basic WPRD*.

Display a fare rule using segment select WPRD*S(segment number)
WPRD*S3

Display applicable fare rules for the specified line following a WQ or
WPA response

WQRD*L(line number)
WQRD*L2

Note: If you do not include a line number, the response defaults to
rules for fare on line number one.

WPRD*L(line number)
WPRD*L4

Display a fare rule using a fare basis code

Note: If this fare contains a ticket designator, you can also use this
designator in the enhanced rule display entry

WPRD*Q(fare basis code)
WPRD*QYLEE35

WPRD*Q(fare basis code)/(ticket designator)
WPRD*QYLEE35/TTC

Display a fare rule using the rule category number (50 maximum)

Note: Displays only the requested rule category of the fare rule.
Separate multiple numbers with a slash. You cannot enter a category
range.

WPRD*C(category number)
WPRD*C4
WPRD*C5/2

Display a fare rule using the rule category two-letter alpha code (5
maximum)

Note: Displays only the requested rule category of the fare rule.
Separate multiple alpha codes with a slash. See the Format FinderSM

help system for a list of alpha codes.

WPRD*(category two-letter alpha code)
WPRD*EE/IC/TI

You cannot combine category numbers and alpha codes in the same enhanced rule display entry. You cannot combine rule categories with the rule
display menu, routing map, rule display header, international construction, and combinability category control record.
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You cannot combine the following formats with each other.

Display a fare rule requesting the rule menu
WPRD*M
WPRD*M«

V FARE BASIS BK FARE TRAVEL-TICKET AP MINMAX RTG
1 Y2US Y‡X 1527.00 ---- - -/ - AT01

PASSENGER TYPE-ADT AUTO PRICE-YES
FROM-DEN TO-LON CXR-BA TVL-23APR09 RULE-2003 IPRA/1
FARE BASIS-Y2US NORMAL FARE DIS-N VENDOR-ATP
FARE TYPE-EU OW-ECONOMY UNRESTRICTED
USD 1527.00 0023 E16JAN09 D-INFINITY FC-Y2US FN-
SYSTEM DATES - CREATED 15JAN09/1732 EXPIRES INFINITY

*50.RULE APPL 01.ELIGIBILITY 02.DAY/TIME
03.SEASONS *04.FLIGHT APPL 05.ADV RES/TKTG
06.MIN STAY 07.MAX STAY *08.STOPOVERS

*09.TRANSFERS *10.COMBINATIONS 11.BLACKOUTS
‡12.SURCHARGES 13.ACCOMP TRAVEL 14.TRAVEL RESTR
‡15.SALES RESTR *16.PENALTIES 17.HIP/MILEAGE
18.TICKET ENDO *19.CHILDREN DISC ‡20.TOUR COND DISC

*21.AGENT DISC *22.ALL OTHER DISC *23.MISC PROVISIONS
25.FARE BY RULE 26.GROUPS 27.TOURS
28.VISIT A COUNTRY 29.DEPOSITS ‡31.VOLUNTARY CHGS ‡

Display a fare rule requesting the rule header only WPRD*H

Display a fare rule requesting the routing map WPRD*RTG

Display a fare rule requesting the international construction

Note: You cannot combine combinability category control record with
numeric rule categories, rule display menu, routing map, rule display
header, and rule category record two. However, you can combine with
international construction and with alpha rule categories (maximum of 5).

WPRD*IC

Display a fare rule requesting combinability category control record WPRD*MX

Note: You cannot combine combinability category control record with
numeric rule categories, rule display menu, routing map, rule display
header, and rule category record two. However, you can combine with
international construction and with alpha rule categories (maximum of 5).

Display a fare rule requesting rule category record two information WPRD*FB(category number)
WPRD*FB15

Combination formats

Note: If you use only one qualifier, add it directly after the WPRD*
command. To combine qualifiers, separate them with a Cross of
Lorraine symbol (¥)

WPRD*P(passenger type)¥S(segment number)¥C(category number)
WPRD*PC07¥S3¥C15

WPRD*Q(fare basis code)¥(category two-letter alpha code)
WPRD*QBAPOW¥EE/IC/TI

WQRD*L(line number)¥S(segment number)
WQRD*L6¥S1

H E L P S C R E E N S

You may find additional formats and information in these Sabre system help screens.

Display help screen for WPRD entry. WPRDHELP

Display help screen for WQRD entry. WQRDHELP
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Service type Definition
code

ancillaries and
AIR EXTRAS

Air Extras – Pricing Formats Quick Reference

O V E R V I E W

A growing trend in the travel market is the “unbundling” of fares which result in airlines offering optional services to travelers for a fee; examples are
premium seats, checked baggage and meal fees. Sabre Air Extras provide you with tools to support your customer’s request of these services. Air
Extras allows you to qualify your pricing request with a secondary action code so that the pricing options include applicable ancillary fees. This
applies to the following Sabre system pricing entries/products:

 WP  WP*  WPNC/WPNCS/WPNCB (Bargain
Finder)

A I R E X T R A S P R I C I N G E X A M P L E F O R M A T A N D R E S P O N S E

Use the qualifier of AE to display all applicable Air Extras for the itinerary pricing. If Air Extras exist, the system displays the applicable fees following
the existing fare calculation results, endorsement messages, and any applicable taxes.

When the system finds no fare for the pricing request, it returns existing error messages and does not process the Air Extras request.

Note: The AE format is an optional secondary qualifier.

Price itinerary, specify passenger types 1 adult, 1 child 11 years old
and request all Air Extras

WPP(passenger type code)/ (passenger type code)¥AE
WPP1ADT/1C11¥AE

Itinerary
pricing

response for
adult and child

Air Extras header
- Displays each

service type
code where the
carrier has filed

specific

WPP1ADT/1C11‡AE«
BASE FARE EQUIV AMT TAXES/FEES/CHARGES TOTAL

1- USD2183.00 NGN436600 127449XT NGN564049ADT
XT 54800YQ 24570NG 10000QT 4000TE

21401GB    12678UB 94.40GB 36.10UB

1- USD1637.00 NGN327400 100588XT NGN427988C11
XT 54800YQ 19110NG 10000QT 400TE

12678UB
3820.00 764000 228037 99203TTL

ADT-01 MHWRCAFR BHXRCAR
LOS XX LON899.00 ZZ LOS1283.50H2 NUC2182.50END ROE1.00
CONDITIONS APPLY/NON ENDORSEABLE-BA ONLY
VALIDATING CARRIER - XX
C11- 01 MHWRCAFRCH BHXRCAFRCH
LOS XX LON674.25 ZZ LOS962.62H2 NUC1636.87END ROE1.00
VALIDATING CARRIER - XX

BG Baggage

ML Meal/Beverage

SA Pre-reserved Seat
Assignments

IE In-Flight Entertainment

UN Unaccompanied Passengers

PT Pets

LG Lounge

MD Medical

Display includes
applicable

passenger types
(ADT/C11 or ALL)

and total fee
(base and

applicable taxes)
for each.

-- ALL-FIRST CHECKED BAG XX 1-LOSLHR 0 *
1 ALL-SECOND CHECKED BAG XX 1-LOSLHR 0 X
2 ALL-THIRD CHECKED BAG XX 1-LOSLHR 32814 X
ML-MEAL/BEVERAGE CXR SEG/CPA FEE
3 ALL-SNACK XX 1-LOSLHR 5823 /
4 ALL-STANDARD MEAL XX 1-LOSLHR 15123 /
SA-PRE-RESERVED SEAT ASSIGNMENT CXR SEG/CPA FEE
-- ALL-PREMIUM SEATING XX 1-LOSLHR 9000 ¤
-- ALL-PREMIUM SEATING ZZ 2-LHRLOS 9000 ¤
* FEES ARE FOR INFORMATION/DISPLAY ONLY
X FEE APPLIES TO THE ENTIRE UNIT OF TRAVEL
/ FEE APPLIES FOR EACH SELECTED ITEM
¤ INFORMATION ONLY - USE SEAT MAP TO BOOK/SELL
NO AIR EXTRAS FOUND FOR - IE/GT/LG/MD/PT

Footnotes Definition

¤ (change key) Information only - use seat
map to book/sell

* (asterisk) Fees are for information /
display only

N Service is nonrefundable

P Service must be purchased
at same time as ticket

/ (slash/oblique) Fee applies for each
selected item

In this example, Air Extras for these service type codes do not
exist, have not been filed by the carrier or are unknown.

- (hyphen) Fee may apply for the entire ticket
X Fee applies to the entire unit of travel
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P R I C I N G T A S K S F O R M A T

All pricing qualifiers are available to use in conjunction with Air Extras pricing formats.

Price itinerary and request all Air Extras (AE) WPAE
WPAE

Price itinerary with passenger type and request specific Air Extras
service type code(s)

Note: Maximum of twenty-five (allowing for future expansion)
service type codes allowed, separated by /

WPP(passenger type code)¥AE-(2-character service type code)
WPP1ADT¥AE-BG
WPP1ADT/1C08¥AE-BG/ML/SA/UN/IE

Price itinerary with account code and request specific Air Extras
service type code(s)

WPAC*(account code)¥AE-(2-character service type code)
WPAC*ABC123¥AE-BG

Price itinerary with passenger type and specific Air Extras service
type code(s) and add Frequent Flyer status

Note: Maximum of 25 carriers.

WPP(passenger type code)¥AE-(2-character service type code)/(2-character
service type code)¥FFS-(carrier code)(frequent flyer status)/(carrier
code)(frequent flyer status)
WPP1ADT¥AE-BG/ML¥FFS-XX2/YY7

W P * F O L L O W - U P F O R M A T S

Your pricing response may display trailer messages alerting you to the existence of Air Extras:

 AIR EXTRAS AVAILABLE - SEE WP*AE

Or the existence of additional Air Extras:

 ADDITIONAL AIR EXTRAS AVAILABLE - SEE WP*AE

Use these follow-up formats to display the additional fees.

Follow-up pricing entry with all Air Extras WP*AE

Follow-up pricing entry to request specific service type code(s)

Note: Maximum of twenty-five (allowing for future expansion)
service type codes allowed, separated by /

WP*AE-(2-character service type code)
WP*AE-BG
WP*AE-BG/ML/IE

B A R G A I N F I N D E R T A S K S F O R M A T A N D R E S P O N S E

WPNC¥AE and WPNCS¥AE are eligible to display Air Extras fees;
however, are not eligible to be booked/sold because the itinerary
may not be in the correct inventory. Thus, the fees display with a
trailer message advising that the fees are for display only, and the
option/line number is not available

Note: Display edited to show detail.

WPNC¥AE or WPNCS¥AE

WPNC¥AE«
20DEC DEPARTURE DATE-----LAST DAY TO PURCHASE 14DEC/2359

BASE FARE      EQUIV AMT  TAXES/FEES/CHARGES    TOTAL
1- USD1819.00      NGN363800     149620XT       NGN513420ADT

XT     59000YQ      21140NG      10000QT 4000TE
42802GB      12678UB

3638.00         727600     299240           1026840TTL
ADT-01 MHWRCAFR THXRCAFR
LOS BA LON899.00BA LOS919.50NUC1818.50END ROE1.00

CONDITIONS APPLY/NON ENDORSEABLE-BA ONLY
VALIDATING CARRIER - BA
CHANGE BOOKING CLASS - 1M 2T

AIR EXTRAS
BG-BAGGAGE CXR SEG/CPA FEE
-- ADT-FIRST CHECKED BAG BA 1-LOSLHR 0
-- ADT-SECOND CHECKED BAG BA 1-LOSLHR 0
GT-GROUND TRANSPORTATION CXR SEG/CPA FEE
-- ADT-BIG DOG BA 2-LHRLOS NOT AVAIL
FEES ARE FOR INFORMATION/DISPLAY ONLY
NO AIR EXTRAS FOUND FOR - IE/LG/MD/PT
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1 BA 238B 30NOV 2 BOSLHR SS1 0815 1930 /DCBA
2 AA 155H 09DEC 4 LHRBOS SS1 1755 2045 /DCAA /E¤

F O R M A T

*IA«
1 BA 238B 30NOV 2 LOSLHR SS1 0815 1930 /DCBA
2 AA 155H 09DEC 4 LHRLOS SS1 1755 2045 /DCAA /E

The WPNCB¥AE pricing entry displays Air Extras in the response
after all fare calculation details and any ticketing fee information.
The rebooked itinerary displays after all Air Extras.

Note: Display edited to show detail.

WPNCB¥AE

WPNCB‡AE«
PRICING SEARCH IN PROGRESS - PLEASE WAIT
20DEC DEPARTURE DATE-----LAST DAY TO PURCHASE 14DEC/2359

BASE FARE      EQUIV AMT  TAXES/FEES/CHARGES    TOTAL
1- USD1819.00      NGN363800     149620XT       NGN513420ADT

XT     59000YQ      21140NG      10000QT 4000TE
42802GB      12678UB

3638.00         727600     299240           1026840TTL
ADT-01 MHWRCAFR THXRCAFR
LOS BA LON899.00BA LOS919.50NUC1818.50END ROE1.00

CONDITIONS APPLY/NON ENDORSEABLE-BA ONLY
VALIDATING CARRIER - BA

AIR EXTRAS
BG-BAGGAGE CXR SEG/CPA FEE
-- ADT-FIRST CHECKED BAG BA 1-BOSLHR 0.00 *
1 ADT-SECOND CHECKED BAG BA 1-BOSLHR 39.00 X

GT-GROUND TRANSPORTATION CXR SEG/CPA FEE
-- ADT-BIG DOG AA 2-LHRBOS NOT AVAIL *

ML-MEAL/BEVERAGE CXR SEG/CPA FEE
2 ADT-SNACK BA 1-BOSLHR 8.00 /

Rebooked itinerary

* FEES ARE FOR INFORMATION / DISPLAY ONLY
X FEE APPLIES TO THE ENTIRE UNIT OF TRAVEL
/ FEE APPLIES FOR EACH SELECTED ITEM
NO AIR EXTRAS FOUND FOR IE/LG/MD/PT

H I S T O R I C A L / F U T U R E D A T E FORMATS

When you request historical or future date pricing (WPB) with the AE
action code, the Air Extras are identified as display only. The fees
display with a trailer message advising that the fees are for display
only, and the option/line number is not available.

WP«

WPB(date, month year)¥AE
WPB25NOV10¥AE

Note: Display edited to show detail.

20NOV DEPARTURE DATE-----LAST DAY TO PURCHASE 14DEC/2359
BASE FARE      EQUIV AMT  TAXES/FEES/CHARGES    TOTAL

1- USD1819.00      NGN363800     149620XT       NGN513420ADT
XT     59000YQ      21140NG      10000QT 4000TE

42802GB      12678UB
3638.00         727600     299240           1026840TTL

ADT-01 MHWRCAFR HHXRCAFR
LOS BA LON899.00BA LOS919.50NUC1818.50END ROE1.00

CONDITIONS APPLY/NON ENDORSEABLE-BA ONLY
VALIDATING CARRIER - BA

AIR EXTRAS AVAILABLE - SEE WP*AE

WPB25NOV10‡AE«
BASE FARE      EQUIV AMT  TAXES/FEES/CHARGES    TOTAL

1- USD1819.00      NGN363800     149620XT       NGN513420ADT
XT     59000YQ      21140NG      10000QT 4000TE

42802GB      12678UB
3638.00         727600     299240           1026840TTL

ADT-01 MHWRCAFR THXRCAFR
LOS BA LON899.00BA LOS919.50NUC1818.50END ROE1.00

CONDITIONS APPLY/NON ENDORSEABLE-BA ONLY
VALIDATING CARRIER - BA

AIR EXTRAS
BG-BAGGAGE CXR SEG/CPA FEE
-- ADT-FIRST CHECKED BAG BA 1-BOSLHR 0.00 *

ADT-SECOND CHECKED BAG BA 1-BOSLHR 39.00 X

GT-GROUND TRANSPORTATION CXR SEG/CPA FEE
-- ADT-BIG DOG AA 2-LHRBOS NOT AVAIL *

ML-MEAL/BEVERAGE CXR SEG/CPA FEE
ADT-SNACK

FEES ARE FOR INFORMATION/DISPLAY ONLY
NO AIR EXTRAS FOUND FOR - LG/MD/PT
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